Oracle® Rapid Planning
Implementation and User's Guide
Release 12.1
Part No. E14573-03

May 2010
Send Us Your Comments

Preface

1 Overview
Rapid Planning Functionality................................................................. 1-1
Data Collection .................................................................................. 1-2
Simulation Set ................................................................................... 1-2
Rapid Planning Solver ...................................................................... 1-3
Rapid Planning Workbench ............................................................... 1-3
Plan Comparison and Analytics ....................................................... 1-3
Integrations ...................................................................................... 1-3
Scenarios .......................................................................................... 1-4

2 Planning Solver
Planning Solver Overview ................................................................. 2-1
Planning Solver Logic ....................................................................... 2-3

3 Navigating Oracle Rapid Planning
Responsibility and Menus ................................................................. 3-1
Rapid Planning Workbench ............................................................... 3-1
Plan Availability for Update ............................................................. 3-3

4 Using Workbench Tabs
Operating in Tabs ............................................................................ 4-1
Managing Simulation Sets ................................................................. 4-6
5 Using Workbench Exceptions and Metrics

Exceptions Overview ........................................................................................................... 5-1
Exception Messages ............................................................................................................. 5-2
Metrics Overview ................................................................................................................ 5-13
Base Metrics ....................................................................................................................... 5-14

6 Managing Plans

Workbench Actions ............................................................................................................. 6-1
Multiple Planners Working On the Same Plan ................................................................. 6-5

7 Setting Up Oracle Rapid Planning

Architecture ......................................................................................................................... 7-1
Deployment ......................................................................................................................... 7-1
Function and Data Security ............................................................................................... 7-4
Plan Options ....................................................................................................................... 7-11
Profile Options ................................................................................................................... 7-13

Index
Oracle welcomes customers' comments and suggestions on the quality and usefulness of this document. Your feedback is important, and helps us to best meet your needs as a user of our products. For example:

- Are the implementation steps correct and complete?
- Did you understand the context of the procedures?
- Did you find any errors in the information?
- Does the structure of the information help you with your tasks?
- Do you need different information or graphics? If so, where, and in what format?
- Are the examples correct? Do you need more examples?

If you find any errors or have any other suggestions for improvement, then please tell us your name, the name of the company who has licensed our products, the title and part number of the documentation and the chapter, section, and page number (if available).

Note: Before sending us your comments, you might like to check that you have the latest version of the document and if any concerns are already addressed. To do this, access the new Oracle E-Business Suite Release Online Documentation CD available on My Oracle Support and www.oracle.com. It contains the most current Documentation Library plus all documents revised or released recently.

Send your comments to us using the electronic mail address: appsdoc_us@oracle.com

Please give your name, address, electronic mail address, and telephone number (optional).

If you need assistance with Oracle software, then please contact your support representative or Oracle Support Services.

If you require training or instruction in using Oracle software, then please contact your Oracle local office and inquire about our Oracle University offerings. A list of Oracle offices is available on our Web site at www.oracle.com.
Preface

Intended Audience

See Related Information Sources on page viii for more Oracle E-Business Suite product information.

Deaf/Hard of Hearing Access to Oracle Support Services

To reach Oracle Support Services, use a telecommunications relay service (TRS) to call Oracle Support at 1.800.223.1711. An Oracle Support Services engineer will handle technical issues and provide customer support according to the Oracle service request process. Information about TRS is available at http://www.fcc.gov/cgb/consumerfacts/trs.html, and a list of phone numbers is available at http://www.fcc.gov/cgb/dro/trsphonebk.html.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation accessible to all users, including users that are disabled. To that end, our documentation includes features that make information available to users of assistive technology. This documentation is available in HTML format, and contains markup to facilitate access by the disabled community. Accessibility standards will continue to evolve over time, and Oracle is actively engaged with other market-leading technology vendors to address technical obstacles so that our documentation can be accessible to all of our customers. For more information, visit the Oracle Accessibility Program Web site at http://www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an otherwise empty line; however, some screen readers may not always read a line of text that consists solely of a bracket or brace.

**Accessibility of Links to External Web Sites in Documentation**

This documentation may contain links to Web sites of other companies or organizations that Oracle does not own or control. Oracle neither evaluates nor makes any representations regarding the accessibility of these Web sites.

**Structure**

1. Overview
2. Planning Solver
3. Navigating Oracle Rapid Planning
4. Using Workbench Tabs
5. Using Workbench Exceptions and Metrics
6. Managing Plans
7. Setting Up Oracle Rapid Planning

**Related Information Sources**

**Integration Repository**

The Oracle Integration Repository is a compilation of information about the service endpoints exposed by the Oracle E-Business Suite of applications. It provides a complete catalog of Oracle E-Business Suite's business service interfaces. The tool lets users easily discover and deploy the appropriate business service interface for integration with any system, application, or business partner.

The Oracle Integration Repository is shipped as part of the E-Business Suite. As your instance is patched, the repository is automatically updated with content appropriate for the precise revisions of interfaces in your environment.

**Oracle Advanced Supply Chain Planning Implementation and User's Guide**

Oracle Advanced Supply Chain Planning provides information about supply chain planning. Oracle Rapid Planning and Oracle Advanced Supply Chain Planning share many features.

**Oracle Inventory User's Guide**

Oracle Inventory provides setup information for Oracle Rapid Planning.
Do Not Use Database Tools to Modify Oracle E-Business Suite Data

Oracle STRONGLY RECOMMENDS that you never use SQL*Plus, Oracle Data Browser, database triggers, or any other tool to modify Oracle E-Business Suite data unless otherwise instructed.

Oracle provides powerful tools you can use to create, store, change, retrieve, and maintain information in an Oracle database. But if you use Oracle tools such as SQL*Plus to modify Oracle E-Business Suite data, you risk destroying the integrity of your data and you lose the ability to audit changes to your data.

Because Oracle E-Business Suite tables are interrelated, any change you make using an Oracle E-Business Suite form can update many tables at once. But when you modify Oracle E-Business Suite data using anything other than Oracle E-Business Suite, you may change a row in one table without making corresponding changes in related tables. If your tables get out of synchronization with each other, you risk retrieving erroneous information and you risk unpredictable results throughout Oracle E-Business Suite.

When you use Oracle E-Business Suite to modify your data, Oracle E-Business Suite automatically checks that your changes are valid. Oracle E-Business Suite also keeps track of who changes information. If you enter information into database tables using database tools, you may store invalid information. You also lose the ability to track who has changed your information because SQL*Plus and other database tools do not keep a record of changes.
Rapid Planning Functionality

You can use Oracle Rapid Planning to copy and re-generate plans to:

• Create fast, what-if simulations

• Quickly run alternative scenarios

• Compare plan metrics to help select the best solution
The source of rapid planning data is the Oracle e-Business Suite, releases 11i10 and 12.1.1.

It comes to Oracle Rapid Planning through a collections process.

After the collected data is in the planning server, you can use it unchanged for plans or you can change it individually or in a mass update. You store your changes in a simulation set and apply it to this plan or another plan.

You can perform logical operations on the collected data, for example, disabling a component and changing the working days on a calendar and store it in a simulation set.
Rapid Planning Solver

The Rapid Planning solver is the engine that performs the planning process.

Rapid Planning Workbench

Using the Oracle Rapid Planning workbench, you can view plan inputs, quickly simulate changes, and create, manage, and launch plans. It contains analytic displays and drill-down capabilities.

More than one planner can work on the same plan at the same time.

Plan Comparison and Analytics

You can see key performance indicators and metrics:

- For one plan
- Compared among multiple plans
- For your favorites, for example, resources and suppliers

Integrations

Applications

Oracle Rapid Planning integrates with other Oracle e-Business Suite Value Chain Planning applications.

Oracle Advanced Supply Chain Planning and Oracle Value Chain Planning

You use the same collections processes to collect the e-Business Suite source data and Oracle Value Chain Planning data to Oracle Rapid Planning

Oracle Demand Planning and Oracle Demantra Demand Management

You can use consensus forecasts to drive the plans

Oracle Advanced Planning Command Center

You can view Oracle Rapid Planning information in Oracle Advanced Planning Command Center for supply chain analysis.

See Oracle Advanced Planning Command Center User’s Guide for information about:

- Supply Chain Analyst Dashboard Pages, Oracle Advanced Planning Command Center User’s Guide
• Supply Demand Plan Drilldowns, Oracle Advanced Planning Command Center
• Resource Plan Drilldowns, Oracle Advanced Planning Command Center User’s Guide
• Exceptions Reports Drilldowns, Oracle Advanced Planning Command Center User’s Guide
• Measures, Oracle Advanced Planning Command Center User’s Guide

Oracle Global Order Promising

Oracle Global Order Promising works almost the same with Oracle Rapid Planning as it does with Oracle Advanced Supply Chain Planning.


Integration Points

You can release planned orders, reschedules, and cancellations to Oracle e-Business Suite. In addition, plans can be downloaded to Demantra Sales and Operations Planning where they can provide input into the consensus planning process. Once new consensus forecasts have been agreed upon, they can be uploaded to Rapid Planning for additional simulation and planning. This cycle can be repeated as many times as necessary until an operational plan has been achieved.

For more information about the integration between Rapid Planning and Demantra Sales and Operations Planning, please refer to "Demantra Sales and Operations Planning to Rapid Planning Integration", Oracle Demantra Implementation Guide.

Scenarios

You can use Oracle Rapid Planning in many situations, for example,

• Hot demand
• Engineering change cut-in
• Yield bust
• Resource downtime

Hot Demand

This is a possible scenario for processing a hot demand.

You have a production plan.

You receive information on a hot demand.

Copy your production plan to a new plan named Hot Demand.
View the Supply Chain Bill for the demanded item.

Navigate to the Material Plan view. Note the supply, demand, and projected available balance.

Navigate to the Supply/Demand view, enter the hot demand, and assign it a high priority.

Re-navigate to the Material Plan view and notice the impact of the hot demand, including the negative projected available balance.

Save the Hot Demand plan.

Run plan Hot Demand without changing current orders.

Note that the planned date for the hot demand is unacceptably late.

Re-run plan Hot Demand with the ability to change current orders.

Review key performance indicators, favorites, and order comparison information between the production plan and the Hot Demand plan.

If the Hot Demand plan is the more acceptable plan, release planned orders from it.

**Engineering Change Cut-in**

This is a possible scenario for processing an engineering change order cut-in.

You have a production plan.

You receive information on a phase out-phase in bill of material change

Copy your production plan to a new plan named ECO Change 1.

Navigate to the Bill of Material view and modify the bill of material by changing the effectivity dates.

Run plan ECO Change 1.

Navigate to the Horizontal Plan screen and review the projected available balance for the two components. Check for a large final projected available balance on the phase-out component.

Compare key metrics, for example, excess inventory monetary value and late days, between the production plan and plan ECO Change 1.

If there is, for example, unacceptable excess inventory monetary value, copy your plan ECO Change 1 to a new plan named ECO Change 2.

Re-navigate to the Bill of Material Edit/Update screen and modify the bill of material with a new cut-in date.

Run plan ECO Change 2.

Navigate to the Material Plan view and review the projected available balance for the two components.

Compare key metrics, for example, excess inventory monetary value and late days,
between the plan ECP Change 1 and plan ECO Change 2
Release planned orders from the more acceptable ECO Change plan.

Yield Bust

This is a possible scenario for processing a yield bust.
You have a production plan.
You receive information on a reduction in inventory by 100 pieces due to a yield bust.
Copy your production plan to a new plan named Supply Change
Navigate to the Supply/Demand view and lower the inventory by 100 pieces.
Navigate to the Material Plan view and note the projected available balance change.
Run plan Supply Change.
Compare key metrics between the production plan and plan Supply Change.
If you find that the results from the Supply Change plan are unacceptable, check alternate components and find one with supplier capacity of 100 per day.
Negotiate with your supplier for supply of an alternate component.
Re-run plan Supply Change.
Re-compare key metrics between the production plan and plan Supply Change.
If the Supply Change plan is the more acceptable plan, release planned orders from it.

Resource Downtime

This is a possible scenario for processing a resource downtime.
You have a production plan.
You receive information on a down bottleneck resource for all of next week.
Copy your production plan to a new plan named Resource Downtime.
Navigate to the Resource Availability view and decrease the resource availability for next week to zero.
Run plan Resource Downtime
Compare key metrics between the production plan and plan Resource Downtime.
If you find that the results from the Resource Downtime plan are unacceptable, check alternate resources.
Negotiate for overtime on an alternate resource for next week.
Re-navigate to the Resource Capacity view and increase the alternate resource availability for next week by 20%.
Re-run plan Resource Downtime.
Re-compare key metrics between the production plan and plan Resource Downtime.

If the Resource Downtime plan is the more acceptable plan, release planned orders from it.
Planning Solver Overview

The planning solver is the engine that performs the planning process.
Since it emphasizes quickly solving issues and quickly processing simulations, its results may not be the same as those from Oracle Advanced Supply Chain Planning.

Planning Method

Many supply chain planning problems are prioritized supply-demand matching problems. The Planning Solver plans order by order based strictly on their priority sequence. You can see the rationale for why the Planning Solver planned a demand in a certain way by looking at how it planned higher priority demands.

Once the Planning Solver has planned an order, it locks the resources and material used from other orders. It rarely disturbs the plan for a higher priority order in the service of a lower priority order.

The Planning Solver attempts to minimize plan nervousness; small changes in input data should not cause large changes to output.

Unconstrained and Constrained Plans

You can run rapid plans that are:
- Unconstrained: Assumes unlimited capacity
- Constrained – enforce capacity constraints: Capacity constraints take precedence over demand due dates

Key Features

The Planning Solver plans:
• Alternates: Bills of material, components, and resources
• Effectivities: Component, process
• End item substitution
• Order modifiers, including rounding control, but not Fixed Days Supply
• Safety stock: Time-based, only safety lead time
• Coproducts and by-products
• Firming
• Planning time fence
• Calendars: Manufacturing, shipping, carrier
• Supplier capacity consideration

It does not plan these situations:
• Global forecasts: Forecasts not tied to an organization
• Hub and spoke planning
• Minimum transfer quantity (MTQ)
• Aggregate resources
• Sequence dependent setups
• Shelf life

Plan Options
• Before solving a plan, you set plan options.
• There are some plan options that default from profile options.

Release to Execution System
You can release planned orders for make, buy, and transfer to the Oracle e-Business Suite source instance. The release process creates new purchase requisitions or work in process jobs. You can release reschedules for work in process jobs, purchase requisitions and purchase orders
Planning Solver Logic

If you know some basics of how the planning solver works, you can better understand its actions.

Feature Comparison

These are planning solver features that Oracle Rapid Planning shares with the Oracle Advanced Supply Chain Planning engine. For more information on the features, see Oracle Advanced Supply Chain Planning Implementation and User’s Guide.

Collections

Forecast Consumption: Organization specific forecasts
Forecast Spreading
Forecast Consumption: Item substitution
Overwrite Options: All or None only
Demand Priority Rules
Planned Item Selection: Similar to plan type
Sourcing Rules, Bills of Distribution, Assignment Sets
Sourcing Effectivity
Sourcing Ranks
Supplier Capacity
Supplier Calendars
Supplier Order Modifiers
Supplier Specific Lead-time
Alternate Resources
Simultaneous Resources
Maximum Assigned Units
Lot Based Resources
Lead-time and Planning Time Fence
Safety Stock: Item attribute percent only. Calculate safety stock lead-time (SSLT) from SS % item attribute. Schedule each supply earlier by the SSLT value
Calendars: Shipping, Receiving, and Supplier Capacity
Scheduled Receipts: Non-standard Oracle Work in Process jobs
Exception Messages: Oracle Rapid Planning exception messages are different from Oracle Advanced Supply Chain exception messages.
Release Planned Orders
Unconstrained Planning
Item Constraints: Bill of Material Effectivity
Engineering Change Orders
Alternate Bills of Material and Routing
Substitute Components
By-products
Order Modifiers: Except Fixed Days Supply
Resource Constraints: Routing Effectivity
Alternate Routings
Routing Operation Yield
Resource Capacity
Resource Workday Calendar
Resource Efficiency and Utilization: Daily buckets
Firm Work Orders
Phantom Routings
Routing Effectivity
Co-products
Flow Manufacturing
End Item Substitution
Substitute Components
Alternate BOM/Routing
Alternate Resources
Alternate Sources

**Plan Options Comparison**

These are planning solver features enabled by plan options that Oracle Rapid Planning shares with the Oracle Advanced Supply Chain Planning engine. For more information on the features, see *Oracle Advanced Supply Chain Planning Implementation and User’s Guide*.

Plan Item Type
Planned Items
Material Scheduling Method: Operation start date only
End Item Substitution Set
Assignment Set
Simulation Set
Demand Priority Rule
Overwrite: All or None only
Demand Time Fence Control
Planning Time Fence Control
Enable Forecast Spreading
Consume by Forecast Bucket
Explode Forecast
Backward Days
Forward Days
Plan Horizon
Daily Buckets
Organization
Sub-inventory Netting
Demand Schedule: Name, Description, and Type

**Item Attributes**

These are item attributes that the planning solver uses. For more information on the features, see *Oracle Inventory User’s Guide* and *Oracle Advanced Supply Chain Planning Implementation and User’s Guide*.

Planner
Make or Buy
Safety Stock Percent
Minimum Order Quantity
Maximum Order Quantity
Fixed Order Quantity
Fixed Lot Multiplier
Planning Method
Create Supply
Round Order Quantities
Shrinkage Rate
Planning Time Fence
Planning Time Fence Days
Demand Time Fence
Demand Time Fence Days
Release Time Fence
Release Time Fence Days
DRP Planned
Preprocessing Leadtime
Processing Leadtime
Post-processing Leadtime
Fixed Leadtime
Variable Leadtime
Use Approved Supplier
New Selling Price
Selling Price
Standard Cost

Items to Plan

There are two plan options that determine the items that are included in the plan.

Planned Item Type: For Oracle Rapid Planning plans, this option is the same as Plan Type for Oracle Advanced Supply Chain Planning plans:

• MPS Planned: Include items with Planning Method of MPS Planned and MPS/MPP Planned

• MPP Planned: Include items with Planning Method of MPP Planned, MPS/MPP Planned, and MRP/MPP Planned

• MRP Planned: Include all planned items, that is, include all items unless Planning Method is Not Planned

• Distribution Planned: Include all items that are Distribution Planned. There is no separate distribution planning logic in Oracle Rapid Planning.

Planned Items: Specifies the types of items that the planning engine should plan in a particular plan run:

• All Planned Items
• Demand Schedule items only: Only plan items that have demands. If plan option Include Sales Orders is selected, include only sales orders against those items found in demand schedules.

• Demand Schedule and WIP components

• Demand Schedule Items and all sales orders: Plan all items that have demands as well as all items that have sales orders against them.

• Demand Schedule Items, WIP components and all sales orders

The largest possible item list is a plan where you select:

• Planned Item Type: MRP Planned

• Planned Items: All Planned Items

Oracle Rapid Planning does not use Oracle Advanced Supply Chain Planning plan option Critical Component. Use a simulation set and update item attribute Planning Method.

Phantoms

Oracle Rapid Planning plans phantom assemblies in the same way that it plans standard items.

You cannot release planned orders for phantom assemblies.

Oracle Rapid Planning does not use profile option MSC: New Planner Backward Compatibility

Unconstrained Planning

For unconstrained planning Oracle Rapid Planning uses these entities and methods.

Item-organization item attribute Planning Time Fence:

• It does not set any planned order Suggested Due Dates earlier than Planning Time Fence Date.

• It uses Due Date to determine if the supply is earlier than, later than, or on Planning Time Fence Date.

• It firms work orders and operations with the time fence.

Demand Time Fence and Release Time Fence

Firm flags on supplies

Does not select alternates
Order modifiers: Not Fixed Days Supply

Overloads resource and supplier capacity: Backwards schedules resources and does not schedule them early or before the plan run date.

Issues exceptions for resource capacity overload, supplier capacity overload, lead-time, sales order and forecast at risk due to a material shortage and sales order and forecast at risk due to a resource shortage.

Date calculations the same as in Oracle Advanced Supply Chain Planning. See *Oracle Advanced Supply Chain Planning Implementation and User’s Guide*.

Compression:

- **Make orders:** For schedule and reschedule of WIP jobs and planned orders for make items, the first several operations of the make order can be compressed, and the operation start dates and end dates equal the planning run date. Compression begins at the first operation; each successive operation is compressed to no duration until there is sufficient lead time for the remaining operations to complete using the resource duration.

- **Buy orders and transfer orders:** For schedule and reschedule purchase orders, purchase requisitions and planned orders for purchased items, the compression occurs in the order pre-processing lead-time, then processing lead-time, and then post-processing lead-time.

Lead times for make supplies by using the routing resource requirements and the maximum available hours per day for a resource. Each resource lead time is calculated as:

\[
\text{Lead time} = \frac{\text{Resource Usage}}{(\text{maxAssignedUnits} \times \text{maxDailyResourceHrs})}
\]

where:

- \(\text{maxDailyResourceHrs} = \text{Maximum hrs per resource in a day from estimated order start to order due date}\)

- \(\text{Estimated Order Start} = \text{Order Due Date} - [\text{Fixed LT} + (\text{Variable LT} \times \text{Qty})]\)

- \(\text{Order Due Date} = \text{the same as demand due date}\)

- \(\text{Order due date and order start date are valid working days from mfg org calendar.}\)

- \(\text{Resource usage} = \text{Order Qty} \times \text{Usage per item from the routing (except for a lot based resource, do not multiply by order quantity)}\)

- \(\text{maxAssignedUnits} = \text{the maximum assigned units from the routing}\)

These are lead time notes:

- If there are simultaneous resources, it bases the lead time is based on the longest lead time resource.
• If fixed and variable lead times are blank, the estimated order start is the plan start date

**Flow Manufacturing**

This is how Oracle Rapid Planning works with flow manufacturing items. Identifies flow manufacturing items by their flow routing. Collects flow schedules. Treats flow schedules as firm:

• Explodes the component demand

• Explodes the Resource requirements

• Ignores the Flow Line requirement

Creates planned orders for flow items:

• They have order type Flow Schedule

• They are constrained with respect to the resources. It ignores the flow line capacity and line rate

• They are constrained with respect to the components

To model a flow line rate:

• Leave current resources unconstrained

• Add a dummy line rate resource with the line rate and then

• Use a simulation set to constrain the dummy line rate resource

**Daily Bucketing**

Oracle Rapid Planning buckets these entities by day. Resource and supplier capacity. It:

• Is a strategic planning tool that wants to minimize planning solver processing time

• Does not do detailed shop floor scheduling and does not schedule resources down to the minute.

Demands and supplies. It does not assign a timestamp

Available resource capacity:
• If a make order is scheduled that uses 8 hours of capacity on Day 1 and 1 hour of capacity on Day 2, the planning solver does not assign a particular hour for the resource requirement on either Day 1 or Day 2.

• The planning solver assumes that resource capacity availability in a daily bucket is continuous.

Work in process job completion dates. The job completion date is typically in the last daily bucket where the final activity consumes resource capacity but can be later in some cases. These are the scheduling rules:

• A single resource activity is typically scheduled within a single daily bucket. The resource activity can be scheduled in two contiguous daily buckets with some resource usage on each day. However, a single resource activity is never scheduled in non-contiguous daily buckets.

• A single resource requirement for two hours or less is scheduled in a single daily bucket.

• In a single operation, two or more resources are always scheduled contiguously. That is, there are never daily gaps in the scheduled resources for a single operation.

• Two operations can be scheduled with gaps more than one day between the operations.

• If the planning solver cannot bucket all of the resource usage into a daily buckets, it creates multiple planned orders for scheduling flexibility.

Large resource requirements:

• If resource requirements are more than one day for a single resource, the planning solver expands the resource capacity bucket and spreads the resource requirement over several days.

• The plan information shows the start date and the end date of the resource requirement and also shows the resource usage on each day. The start date and end date of the resource requirement may not match the resource usage precisely due to the estimation of lead time.

• It schedules resources within an operation contiguously

• It does not necessarily schedule operations contiguously

• It can schedule resource requirements more than two hours over contiguous daily buckets

• If it must bucket some resource requirements into larger than daily buckets, it can still use daily buckets for the other resource requirements on the routing.
Order and Resource Firming

You can firm supplies in these ways.

Planned orders; you can:

- Firm the supply and enter a new date and a new quantity
- For a make at order, select and firm an alternate bill of material and routing combination. If you do not re-run the plan after this change, a release of the planned order only creates the order header
- For a buy from order, select and firm an alternate source.
- Select and firm a substitute component.

Non-firm work in process job:

- You can firm the supply and enter a new end date. Re-run the plan to have the planning solver recalculate the resource and component requirements in the next plan run.
- If you firm a work in process job in the source, the planning solver does not change its resource and component requirements

Non-firm purchase order:

- Firm the supply and enter a new date and a new quantity
- The planning uses Suggested Due Date unless you enter New Date. The planning solver then sets the Suggested Due Date to the New Date and reschedules all related activities.

Scheduling Firm Supplies

The planning solver does not change the suggested due date or quantity of a firm supply.

When the supply is firm the planning solver:

- Cannot change resource schedules
- Can overload resource or supplier capacity

The planning solver first processes firm work orders and firm planned make orders against the highest priority demands. It does this without regard to the demand priorities. However, it never makes a demand late by using a firm order.

After it processes firm work orders, then it schedules supplies for demands by priority using non-firm work orders and planned orders.
If a supply is firm, the planning solver treats all upstream supplies as pegged to a firm and they are not allowed to be late. This means that these orders can be compressed in the same manner as unconstrained planning. This does not apply to supplies that are firmed because of the planning time fence.

**Scheduling Non-firm Supplies**

To schedule non-firm supplies, the planning solver uses the same idea as scheduling firm supplies but also considers supplies that are after the demand due date.

This is the process:

- The planning solver uses non-firm supplies and does not change the suggested due date order of work in process supplies needlessly.

- It continues to use non-firm supplies until it has selected all of them.

- For non-firm supplies that are later than the demand date, the planning solver tries to reschedule them in to meet the demand on time. It does not select alternate resources, substitute components, or alternate bill of material and routing combinations for work in process supplies.

- If this is not possible for a supply, the planning solver creates planned orders to meet the demand on time.

- If this is not possible for a supply, the planning solver creates planned orders as close to the demand date as possible. If a planned order date is the same as a scheduled receipt and there is available capacity for the existing supply, it uses the scheduled receipt for the lower priority demand as well, even though the supply may be late.

To specify your preferences for work order vs. planned order pegging, you can use Oracle Rapid Planning item attribute No planned orders before WIP window in simulation sets.

- The default value is 10.

- Work orders outside of this window do not affect planned order creation.

- In this number of days from plan start date, the planning solver does not create planned orders that are due earlier than work orders are due.

- It tries to reschedule in the work orders first, then uses planned orders outside this window if work order reschedules will meet the demand late.

The planning solver right-justifies non-firm orders to the right to minimize excess. It does this only if they are outside of the range you specify in item-organization attribute Acceptable Early Days.
Creating Supplies

The planning solver does not create planned orders if:

• There is no available resource capacity or material capacity during the planning horizon

• The plan horizon is shorter than the lead times, planned orders are not created

Oracle Advanced Supply Chain Planning creates planned orders at the end of the plan horizon due to constraints during the plan horizon. The Oracle Rapid Planning solver generates exception message Demand Quantity not Satisfied and does not create planned orders at the end of the plan.

Order Release

When you release planned orders to the execution system, this is the information that Oracle Rapid Planning passes.

It auto-releases planned orders within the release time fence.

Work orders:

• Job details with start date and end date timestamps of 23:59:59

• Resource details with resource scheduled start date and resource scheduled end date timestamps of 23:59:59

• Resource usage

• Resource hours

• Primary or alternate bill of material and routing combination selection

• Primary or substitute component selection

• Primary or alternate resources selection

Purchase requisitions:

• Selected supplier, supplier site, and ship method

• Suggested Due Date timestamp of 23:59:59

Internal requisitions:

• Selected source organization and ship method

• Order Date timestamp of 23:59:59
Rescheduled work orders:

- End date
- If the plan determined the work order start date, all the remaining information in the order is new

Reschedule or cancellation of purchase requisitions:

- Order number
- Order Date timestamp of 23:59:59

Reschedule or cancellation of purchase orders:

- Order number
- Order Date timestamp of 23:59:59

Reschedule or cancellations of internal requisitions:

- Order number
- Order Date timestamp of 23:59:59

Safety Stock Lead Time

The planning solver calculates safety stock lead time if the value of profile option MSC Use Safety Lead Time is Yes.

The calculation is:

- Item attribute Safety Stock Percent / 100
- Rounded up to the next integer

The planning solver uses the safety stock lead time to create supplies that are a number of days earlier than the actual demand. The process is to try to schedule the supply:

- Early by the safety stock lead time
- If this is not possible, halfway between the safety stock lead time and the demand due date
- If this is not possible, on the demand due date

The planning solver:

- Only uses workdays
- Never reschedules earlier that the planning time fence
• Applies safety stock lead time when scheduling components that are MRP Planned and have a safety stock percent

• Schedules using safety stock lead time of the end item substituted and the substitute components

• Does not schedule safety stock lead time for co-products and by-products

Pegging

The planning solver uses basic FIFO (first in first out) pegging. It does not consider Oracle Advanced Supply Chain Planning pegging profile options. See Oracle Advanced Supply Chain Planning Implementation and User’s Guide.

For all demands and supplies, it:

• Pegs demands to supplies day by day. It does not sort each day’s supplies and demands.

• Pegs demands using the material available date. It calculates the material available date as it schedules supplies to satisfy each demand.

• When there are no more supplies or demands on one day, it uses supplies or demands from the next day

• At the end of the planning horizon, it posts un-pegged supplies to excess.

Alternate Supplies

The planning solver considers all alternates as supplies to meet demands.

The search path is depth first and then breadth. During the search, the planning solver may find partial quantities and then continue the search for the remaining quantity required to meet the demand. It uses partial quantities only if they satisfy the order modifiers.

This is the search order.

The primary source is searched first based on the sourcing rules:

• First use on hand, then in receiving, then scheduled receipts

• Check each source all the way down the supply chain for supply availability before considering the next lower ranked source

• Search each alternate source at all levels before moving on to the next alternate source

The sourcing rule primary source is the rank 1 source with the highest % allocation. The
planning solver searches all rank 1 sources with allocation percents before rank 2 sources.

If multiple rank 1 sources have the same allocation percents, then the engine selects one to search first.

If there is make source on the search path:

• First, search the primary bill of material and routing combination using any substitute components and alternate resources

• Then, search each alternative successive bill of material and routing combination using any substitute components and alternate resources. Search alternates in bill of material rank order.

The planning solver continues searching alternate sources until it considers all of them.

Search for the first substitute item using its complete search path.

Continue searching for each successive substitute item using its complete search path.

If the demand cannot be met on time, re-search and attempt to minimize the supply lateness. Use an alternate source may be used to create a late supply if the primary source supply date is after the alternate source supply date.

**Incremental Planning**

Use incremental planning for hot demands. Incremental planning does not re-snapshot planning data.

The incremental plan freezes all:

• Supplies

• Planned orders

• Resource capacity consumption

• Supplier capacity consumption

• Pegging relationships

The planning solver only changes plan output to:

• Create and reshuffle supplies to meet the hot demand and determine when you can meet it

• Recalculate all exception messages

If there are multiple hot demands, the planning solver plans by:

• Highest demand priority
• Then by earliest due date

• Then by lowest quantity

If the incremental plan output is not satisfactory, run a replan; do not run multiple incremental planning runs. If you run incremental planning, run plan launch either with or without snapshot.

Simulation Sets

When you replan, the planning solver does not write snapshot data over your manual changes in the simulation set.

Other Planning Functions

Oracle Rapid Planning works with these functions in the same manner as Oracle Advanced Supply Chain Planning:

• Internal Requisitions and Internal Sales Orders: In Rapid Planning Workbench, internal sales orders display as sales orders.

• Supplier Capacity

• Lot Expiration: Oracle Rapid Planning does not issue exception messages and it does not track onhand for expiration.

Bottleneck Resource Planning

All resources default as bottleneck resources. You must clear the flags manually.

In simulation sets, you can select a bottleneck flag for resources in constrained planning,

• Selected: The planning solver schedules resources to avoid overloads. It may schedule resource requirements early due to resource capacity loads or the planned order late because of resource capacity loads.

• Cleared: The planning solver calculates resources requirements and notes resource duration. It can overload resources and issues exception messages. It schedules the resource requirement as needed and never early because of resource capacity loads. The planned order is never late because of resource capacity loads but can be late because of uncompressed resource duration.

There are no bottleneck resource groups.

End Item Substitution

The planning solver works with only these features of end item substitution. See Oracle Advanced Supply Chain Planning Implementation and User’s Guide.
- One-directional
- Two-directional
- Inference

Planning attributes: If a plan specifies a substitution set, the planning solver uses it. You must use a substitution set for end item substitution.

The planning solver does not use these profile options but behaves as if they are set to these values:
- MSO: Choice of supply for substitution: All supplies
- MSO: Disable Inference of Item Substitution Relationship: Yes.
- MSC: Choice of Items for which to Create Supplies in a Substitute Relationship: Follow Item Attributes
- MSO: Use Effectivity Dates to Infer End Item Substitute Priority: No

You can always use partial substitution supplies to satisfy end demands. The planning solver does not use customer-specific end item substitution rules.

**Supplier Capacity**

If the purchase order promise date is not available, the planning solver uses purchase order need by date to consume supplier capacity.

It accumulates supplier capacity at the beginning of each day. Plans launched during the day will not accumulate supplier capacity until the next day.

The planning solver behaves like this if supplier capacity is missing from the advanced supplier list:
- No supplier capacity entries: Supplier capacity is infinite
- Supplier capacities have gaps: During gaps, supplier capacity is zero
- Future supplier capacity is missing: After the last defined supplier capacity, it is infinite
- Beginning supplier capacity is missing: Before the first defined supplier capacity, it is zero

**Planning Time Fence**

The planning solver uses the planning time fence date.

In unconstrained plans, it does not set any planned order suggested due dates earlier.
than the planning time fence date. It can schedule all other dates before the planning time fence date.

In constrained plans, it schedules planned orders depending on supply type:

- **Make supplies**: It does not set any planned order suggested start dates earlier than the planning time fence date.
- **Buy supplies**: It does not set any planned order dock dates earlier than the planning time fence date.
- **Transfer supplies**: It does not set any planned order start dates at the receiving organization earlier than the planning time fence date.

### Clear to Build

Use clear to build if you need to know whether you can start orders for make items.

If you understand which make orders have delay risks due to the lack of component availability, you can:

- Expedite component supplies
- Readjust and resequence planned production to expedite clear to build metrics of important orders

An order is clear to build if all its components peg to on-hand. If some of its components peg to scheduled receipts, for example purchase order, planned order, transfer order, it is not clear to build.

The planning solver can determine clear to build for:

- Planned orders
- Discrete jobs – unreleased
- Discrete jobs – released: Set profile option Released WIP Jobs: Consider in Clear to Build to Yes.

### Attributes and Options

You set these clear to build item attributes in the simulation set:

- **Consider in Clear to Build**: Determines whether the planning solver calculates clear to build for this item-organization. The default is No.
- **Calculate Clear to Build**: Determines whether the planning solver calculates clear to build in this plan. The default is No.
- **Clear to Build Horizon**: The horizon where the planning solver calculates clear to build KPI metrics. This attribute does not affect when it calculates clear to build for
The planning solver uses the pegging information to calculate these attributes for each make order:

- **Clear to Build**: Yes if all its components are completely available in on hand.
- **Clear to Build Component Availability %**: The percentage of components of the make order, that are completely available on hand.
- **Ready to Build %**: The percentage of the order that you could start now, based on the most constrained component. For this to have a value, all components must at least partially peg to on hand.
- **Clear to Build Date**: The date that the order should be clear to build. It is the date that the latest component material should arrive in on hand. The planning solver uses, for make planned orders, the due date; for buy orders, the dock date plus postprocessing time; and for transfer orders, the receipt date plus postprocessing time.

For example:

- A make order for quantity 100 uses three components
  - Component A usage = 1, need for this order 100
  - Component B usage = 2, need for this order 200
  - Component C usage = 3, need for this order 300
  - Component A pegged to on hand = 20, quantity 80 scheduled to arrive in on hand on June 14
  - Component B pegged to on hand = 20, quantity 180 scheduled to arrive in on hand on June 30
  - Component C pegged to on hand = 40, quantity 260 scheduled to arrive in on hand on June 14
  - Clear to Build = No [all components are not completely available in on hand]
  - Clear to Build Component Availability % = 0 [no components are completely available in on hand]
  - Ready to Build % = 10 [you can start 10 units of the make order, this consumes 10 units of A, 20 units of B, and 30 units of C; (10 units ready to build / 100 order quantity) * 100]
• Clear to Build date = June 30 [component B is the latest to arrive in on hand]

**Clear to Build Across Multiple Levels**

When a higher-level make order pegs to a lower-level make order that is clear to build, the planning server operates as if the lower-level assembly is already available in on hand.

In this example, the planned order for:

• SA123 is clear to build: Its components CM1 and CM2 both peg to on hand

• AS66311 is clear to build: Its component CM3 pegs to on hand. Its component SA123 pegs to on hand because it is a clear to build order.

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Item Type</th>
<th>Required Date</th>
<th>Due Date</th>
<th>Order Quantity</th>
<th>Pegged Quantity</th>
<th>Clear to Build</th>
<th>Clear to Build Component Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS66311 End Item</td>
<td>Sales order</td>
<td>Day 20</td>
<td>-</td>
<td>100</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>. . AS66311 End Item</td>
<td>Planned order</td>
<td>-</td>
<td>Day 20</td>
<td>100</td>
<td>100</td>
<td>Yes</td>
<td>100</td>
</tr>
<tr>
<td>. . SA123 Subassembly</td>
<td>Planned order</td>
<td>-</td>
<td>Day 18</td>
<td>100</td>
<td>100</td>
<td>Yes</td>
<td>100</td>
</tr>
<tr>
<td>. . . CM1 Subassembly component</td>
<td>On hand</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>100</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>. . . CM2 Subassembly component</td>
<td>On hand</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>100</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>. . . CM3 End item component</td>
<td>On hand</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>100</td>
<td>-</td>
<td>-</td>
</tr>
</tbody>
</table>
In this example, the planned order for:

- SA123 is clear to build: Its components CM1 and CM2 both peg to on hand
- AS66311 is not clear to build: Its component CM3 pegs to purchase order. Its component SA123 pegs to on hand because it is a clear to build order

<table>
<thead>
<tr>
<th>Item Description</th>
<th>Order Type</th>
<th>Requested Date</th>
<th>Due Date</th>
<th>Order Quantity</th>
<th>Pegged Quantity</th>
<th>Clear to Build</th>
<th>Clear to Build Component Availability</th>
</tr>
</thead>
<tbody>
<tr>
<td>AS66311 End Item</td>
<td>Sales order</td>
<td>Day 20</td>
<td>-</td>
<td>100</td>
<td>-</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>. AS66311 End Item</td>
<td>Planned order</td>
<td>Day 20</td>
<td>100</td>
<td>100</td>
<td>No</td>
<td>80</td>
<td></td>
</tr>
<tr>
<td>. . SA123 Subassembly</td>
<td>Planned order</td>
<td>Day 18</td>
<td>80</td>
<td>80</td>
<td>Yes</td>
<td>100</td>
<td></td>
</tr>
<tr>
<td>. . . CM1 Subassembly component</td>
<td>On hand</td>
<td>-</td>
<td>-</td>
<td>80</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>. . . CM2 Subassembly component</td>
<td>On hand</td>
<td>-</td>
<td>-</td>
<td>80</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
<tr>
<td>. . . CM3 End item component</td>
<td>Purchase order</td>
<td>-</td>
<td>-</td>
<td>20</td>
<td>-</td>
<td>-</td>
<td></td>
</tr>
</tbody>
</table>

Using Clear to Build Information in the Supply/Demand View

You can use the Supply/Demand view to

- View the clear to build attributes: Clear to Build, Clear to Build Date, Clear to Build Component Availability %, Ready to Build %
- Search on the clear to build attributes
• View the order status: For example, Unreleased or Released

You cannot update the clear to build attributes.

**Using Clear to Build KPIs**

These are the clear to build KPI metrics. Some are available to Oracle Advanced Planning Command Center:

• Clear to Build Orders (%)

• Clear to Build Component Availability %

• Ready to Build %

• Top Shortage Components

• Top Shortage Suppliers

See Base Metrics, page 5-14.

**Clear to Build Simulations**

Use clear to build simulations to try potentially more desirable allocation of on-hand to competing make orders. You do this by:

• Identifying critical make orders that need to be expedited for clear to build

• Prioritizing them

• Deprioritizing other make orders

• Prioritizing and deprioritizing planned orders

• Deprioritizing sales orders

**Clear to Build Simulations: Identifying Critical Make Orders**

In the Supply/Demand view, filter for your key sales orders to identify whether there is any risk associated with replenishing them. Use filters such as:

• Revenue

• Scheduled Ship Date/Due Date

• Customer

• Ship-From Organization

• Item

Use action View Pegged Make Order Supplies. This shows the make orders that peg to
the key sales orders and their clear to build attributes.

Select the orders of concern, and use action Clear to Build Workbench.

**Clear to Build Simulations: Prioritizing Make Orders**

To prioritize make orders that you want to be clear to build, select Clear to Build priority.

This instructs the planning solver to allocate on-hand supply to these orders with priority during the next plan run.

If there is not enough on-hand to satisfy all of the priority clear to build orders, the planning solver allocates it in order of order due date.

**Clear to Build Simulations: Deprioritizing Make Orders**

To deprioritize make orders, select your key make orders, and click View Order contentions.

View the display of contenders—other make orders that are contending for the on hand of the components of your key make orders. The process displays the contenders in the order of the most improvement offered to the key make orders.

Use component allocation to decide which orders to deprioritize.

Select Deprioritize from Clear to Build.

**Clear to Build Simulations: Prioritizing and Deprioritizing Planned Orders**

If you prioritize a firm planned order, the planning solver uses its date, even if there will not be on hand to satisfy its components. It may issue lead time compression and overload exception messages as a result.

If you deprioritize a firm planned order, it retains its firmness and date, and the planning solver may issue exception messages as a result.

If you prioritize a planned order, it becomes a firm planned order.

If you deprioritize a planned order, the planning solver loses that information when it recreated planned orders in the next run.

**Clear to Build Simulations: Priority Flag Retention**

During each run of a plan, the planning solver keeps the clear to build priority and de-priority flags for discrete jobs and firm planned orders.

**Configure to Order**

Oracle Rapid Planning plans these configurations:

- Assemble to order
- Pick to order

It can source the model components:
• All from the same organization
• From multiple organizations within a single instance

Scenarios
Oracle Rapid Planning works with:
• Exploded configure to order forecasts as demand
• Model forecasts that it explodes as demand
• Global forecasting

You can use forecasts from:
• Oracle Demantra
• Oracle Demand Planning
• Oracle E-Business Suite

Oracle Rapid Planning always includes sales orders and always uses them to consume forecasts.

Scenarios: Pre-Exploded Model Forecasts as Demand
Oracle Rapid Planning creates supply for pre-exploded, organization-specific forecasts for assemble to order models that include option class and option forecasts:
• Sales orders consume the forecasts
• Models can be either single or multi-level
• It sources their subassemblies and components using sourcing rules

Oracle Rapid Planning creates supply for pre-exploded, organization-specific forecasts for pick to order model forecasts that include options, items, and ATO model forecasts.
• Sales orders consume the forecasts
• It does not source their subassemblies and components because pick to order model forecasts do not pass to Oracle Rapid Planning.

Oracle Rapid Planning creates supply for pre-exploded, single-instance, global forecasts for assemble to order models that include option classes and options across multiple organizations.
• Sales orders consume the forecasts
• It sources them using sourcing rules and supply availability, either percentage-based or region-based
• It sources their subassemblies and components using sourcing rules at the local organization and planning percentages of each component. For forecasts from Oracle Demantra, it passes the final planning percentage.

Oracle Rapid Planning creates supply for pre-exploded, single-instance, global forecasts for pick to order models that include options, items, and ATO model forecasts.

• Sales orders consume the forecasts

• It does not source their subassemblies and components because pick to order model forecasts do not pass to Oracle Rapid Planning.

**Scenarios: Model Forecasts as Demand for Explosion**

Oracle Rapid Planning explodes and creates supply for organization-specific, assemble to order model forecasts to the options, option classes and mandatory components.

• Sales orders consume the forecasts

• It uses the planning bill of material percentages to explode the model forecasts to each level.

• It sources their subassemblies and components using sourcing rules

Oracle Rapid Planning explodes and creates supply for organization-specific pick to order model forecasts that include options, items, and assemble to order model forecasts.

• Sales orders consume the forecasts

• Pick to order model forecasts do not pass to Oracle Rapid Planning

• You can pass organization-specific pick to order forecasts that are exploded one level down

Oracle Rapid Planning explodes and creates supply for single-instance, global forecasts for assemble to order models that include option classes and options across multiple organizations.

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-based or region-based

• It sources their subassemblies and components using sourcing rules at the local organization and planning percentages of each component.

Oracle Rapid Planning explodes and creates supply for single-instance, global forecasts for pick to order models that include options, items, and ATO model forecasts across multiple organizations.
• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-based or region-based

• It sources their subassemblies and components using sourcing rules at the local organization and planning percentages of each component

**Scenarios: Global Forecasting**

Oracle Rapid Planning creates supply for single-instance, global forecasts for standard items:

• Sales orders consume the forecasts

• It sources them using sourcing rules and supply availability, either percentage-based or region-based

The planning solver distributes forecasts with no constraints. It uses planning percentages and rank 1 sourcing rules.

For assemble to order model forecasts the planning engine in all cases distributes the global forecast based on sourcing rules and planning percentages to meet the model forecast on time.

**Item Attribute Forecast Consumption for Pre-exploded Forecasts**

For the model, set to Consume or Consume & Derive. Oracle recommends that you set to Consume and Derive.

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Recommends that you set to Consume and Derive for Oracle Demantra and Oracle Demand Planning pre-exploded forecasts

• Includes forecasts for ATO Models, PTO Models, Option Classes, Options and Mandatory Components (optional).

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

If you set child items of the model to Consume:

• Oracle Demantra and Oracle Demand Planning do not calculate exploded demand

• Oracle Rapid Planning does not create exploded demand from parents

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Requires that you set to Consume and Derive for Oracle Demantra and Oracle Demand Planning pre-exploded forecasts
• Includes forecasts for ATO Models, PTO Models, Option Classes, Options and Mandatory Components.

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

For mandatory component children of the model, Oracle Rapid Planning:

• Recommends that you set to None

• Calculates exploded demand

• Pegs planned order demand to the model planned order

**Item Attribute Forecast Consumption for Forecast Explosion**

For the model, set to Consume or Consume & Derive. Oracle recommends that you set to Consume and Derive.

For child items of the model other than mandatory components, Oracle Rapid Planning:

• Recommends that you set to Consume and Derive for Oracle Demantra and Oracle Demand Planning forecasts

• Explodes forecasts to assemble to order models, option classes, options and mandatory components

• Performs forecast consumption

• Does not peg forecast demand to the model planned order

If you set child items of the model to Consume, Oracle Rapid Planning does not create exploded demand from parents.

For mandatory component children of the model, Oracle Rapid Planning:

• Recommends that you set to None

• Calculates exploded demand

• Pegs planned order demand to the model planned order

Select plan option Explode Forecast.

If you are using Oracle Demantra, set profile option MSD_DEM: Calculate Planning Percentages and do not change it after the initial download.

If you are using Oracle Demand Planning, set profile option MSD: Calculate Planning Percentage

**Bills of Material**
For models, you can:

- Add models, option classes, and items to model and option class bills of material that you have already defined on the source instance
- Edit Planning Percent for model and option class bills of material
- Edit flag Optional for model and option class bills of material

Use the Plan Input views to make these changes.

**Demand Schedules**

You can select these forecasts as demand schedules:

- Organization-specific configure to order
- Global configure to order: If you have multi-level, multi-organization assemble to order models, Oracle recommends that you use these for proper forecast consumption

For organization-specific configure to order forecasts, use either:

- Pick to order forecasts that contain assemble to order model, option class, and option level forecasts and mandatory components Oracle Demantra does not pass pick to order model forecasts, only its options, items, and assemble to order models
- Assemble to order forecasts that contain model, option class and option level forecasts

For global configure to order forecasts, you import them at these levels:

- Global (Item)
- Organization
- Customer
- Customer site
- Zone
- Customer zone

Set both of these profile options in the master organization:

- Define the item validation organization using the profile option OE: Item Validation Organization.
- Maintain a common bill of material in the Oracle Order Management validation organization and identify that organization in profile option MSC: Organization
After forecast explosion, Oracle Rapid Planning sources global forecasts to organizations in an unconstrained manner based on sourcing rules and planning percentages. It plans based on ship date at the shipping organization and does not attend to constraints in receiving calendars.

**Mandatory Components**

If you pre-explode assemble to order forecasts, you do not need to pass forecasts for mandatory components because Oracle Rapid Planning calculates them from their parents, after it consumes the parents.

For pre-exploded pick to order models, include pre-exploded forecasts for mandatory components.

**Forecast Explosion**

To instruct Oracle Rapid Planning to explode configure to order forecasts, select plan option Explode. It explodes forecasts, then it consumes the forecasts.

**Forecast Consumption**

Set plan option Ship to consumption level. The process consumes forecast entries that have the same Ship To value as it.

For consumption by demand class:

- If a sales order has a demand class, the process consumes a forecast that has the same demand class.

- If a forecast does not have a demand class, the process uses its organization demand class.

- If a sales order does not have a demand class, the process uses its organization’s warehouse demand class.

- If you consume by demand class and have forecasts without demand classes, set profile option MSC: Rapid Planning Consume Forecast with No Demand Class.

For global forecasts, the planning solver:

- Aggregates all sales orders to the level that you want to consume.

- Ignores the organizations on the sales order lines.

- Consumes global forecasts by sales orders in inventory organizations with reference to a ship to entity, for example, zone, customer site, and demand class.

- Distributes forecasts and sales orders to organizations that may have a different demand classes than the ones on the sales orders and may have a different demand classes than the ones that it used for consumption.
Sourcing Rules
Oracle Rapid Planning uses sourcing rules for a configuration first, then for the model, then for the sourcing hierarchy.

For global forecasts, use the profile option MRP: ATP Assignment Set to indicate the assignment set name for use with Oracle Global Order Promising. The planning solver also uses this profile option to determine sources when configuring a model sales order.

Configuration Forecasts
If you build standard configurations to forecasts, and make forecasts both for the model and the configuration, make them customer-specific forecasts. Reduce the model forecasts and their component forecasts by the amount of the configuration forecasts.

The planning solver first consumes forecasts with sales orders for the configured item, then with forecasts for the base model.

Purchased Models
If you purchase assemble to order models and configurations, you can use the Suppliers page > Supplier site to see the constraints for the models and configurations.

You can constrain the purchased configuration by providing the aggregate capacity for the supplier – supplier site to build the base model.

Also, view metrics:
- Supplier capacity utilization %
- Supplier Capacity
- Supplier requirements

The planning solver uses the:
- Approved supplier list capacity for the assemble to order models, not the supplier capacity for any of its configuration items.
- Approved supplier list order modifiers and lead times for the configuration items

Option Dependent Resources
The planning solver treats option dependent resources in model routings as 100% loaded.

This may result in the resource appearing overloaded. Consider making these resources non-bottleneck resources.

Simulation
You can firm and update forecasts for models and configurations and their option classes, options, mandatory components.

However, if you drive a plan with pre-exploded forecasts from Oracle Demantra, there are no pick to order models and option classes for update.
Publish Sales Order Changes

You can release sales order changes to Oracle Order Management. If the sales order is not firmed, you can change Material Available Date and the end item substitute.

Oracle Rapid Planning does not update the source organization for sales orders with:

- Assemble to order models
- Pick to order models and their components, options, and assemble to order models. The planning solver does not change the source organization selected in Oracle Order Management as scheduled by available to promise. Sales order lines for components of pick to order models and kits do not receive any release recommendations.

Default Order Sizing

Use default order sizing if you want to create manageable manufacturing order sizes that are both efficient for scheduling resource usage and are efficient to produce.

Order sizes that are too small create shop floor inefficiencies while order sizes that are too large are difficult to schedule, can cause supplies to be late for demands and usually leave significant amounts of unconsumed resource capacity.

To invoke default order sizing, you specify a planning unit of work--a few hours, a shift, a day, or a larger time bucket.

Planning Unit of Work

Planning Unit of Work is an item-organization attribute that you specify in hours. Oracle Rapid Planning uses planning unit of work to determine the order size. Order size is how many units you can produce within the planning unit of work time.

For example:

- Since the planning solver considers daily capacities, you can decide that it should create planned orders with quantity equal to one production day. In other words, because Oracle Rapid Planning only considers daily capacities, then Oracle Rapid Planning should create units of work that take a full production day.

- If you want long production runs, set the planning unit of work, for example, to two to three days or two to three weeks duration.

The planning solver uses planning unit of work for constrained planning; for unconstrained planning, it uses lead time. It uses planning unit of work to fix the lead time for planned orders so it can quickly arrive at a feasible daily schedule.

Planning Unit of Work Size

The planning unit of work order size is the number of units of an item that you can produce during the planning unit of work time. The planning solver calculates it for each primary and alternate routing by dividing the planning unit of work by the
routing lead time. If you use rounding control, the calculation rounds the planning unit of work order size up.

If you have not defined a Planning Unit of Work, then Oracle Rapid Planning uses order size quantities that can be produced in a day, depending on resource and material availability.

**Resources and Planning Unit of Work**

The planning solver:

- Applies planning unit of work
- Splits resource requirements
- Consumes resource requirements

**Resources and Planning Unit of Work: Applying Planning Unit of Work**

The planning solver backward schedules the resource requirements from the job end time.

The planning solver uses the operation lead time for each operation if resources are available within the time that the lead time covers. For example, if the lead time is 10 hours with 8 hour per day shifts, the lead time spans two days. If the resource requirement is 10 hours using a single assigned unit, then resource capacity usage each day can be anything from 2 to 8 hours.

If the planning solver has to move the operation to an earlier day, it schedules to reflect the resource usage on that day. For example:

- There is four hours of available capacity in the second day of the operation
- The planning solver schedules four hours on the second day
- The planning solver schedules six hours on the previous day

**Resources and Planning Unit of Work: Splitting Resource Requirements**

This is how the planning solver splits resource requirements across daily buckets:

- For resource requirements of two hours or less, it can split them over two contiguous daily buckets. It searches for a bucket with at least two hours available capacity and schedules the remainder of the resource requirement in a contiguous bucket.

- For resource requirements more than two hours, it schedules them in a daily bucket

For example:

- The resource requirement is 4 hours
- The planning solver looks for a bucket that has at least 2 hours (half the
• It finds 3.5 hours in a daily bucket
• It looks in the daily bucket before and after to find the remaining 0.5 hour.

**Resources and Planning Unit of Work: Consuming Resource Availability**

This example shows how the planning solver consumes resources with daily buckets.

Resource availability:
• Resource A: 8 hours per day
• Resource B: 8 hours per day

Routing:
• Operation 1: Uses resource A; resource requirement = 0.25 hour
• Operation 2: Uses resource B; resource requirement = 0.25 hour

Lead time = 0.5 hour \([0.25 + 0.25]\)
Planning unit of work = 16 hours
Planning unit of work order size = 32 \(\frac{16}{0.5}\), you can produce 32 units in 16 hours
For any planned order quantity from 1 to 32 units, total lead time = 16 hours
• Operation 1 lead time = 8 hours
• Operation 2 lead time = 8 hours

Demand
• Quantity: 60 units
• Due date: Day 8

This diagram shows that the planning solver schedules these planned orders:
• Quantity = 20 units, days 1 and 2, lead time = 16 hours

• Quantity = 8 units, days 5 and 6, lead time = 16 hours

• Quantity = 32 units, days 7 and 8, lead time = 16 hours

For the planned order for quantity 32, the planning solver could schedule the operations on the same day:

• Day 8: Operation 1, 8 hours consumed \([32 \times 0.25]\)

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 32, the planning solver could schedule the operations on different contiguous days:

• Day 7: Operation 1, 8 hours consumed

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 32, the planning solver could schedule the operations on different non-contiguous days:

• Day 6: Operation 1, 8 hours consumed

• Day 8: Operation 2, 8 hours consumed

For the planned order for quantity 4, the planning solver could schedule the operations
on the same day:

- Day 8: Operation 1, 1 hour consumed $[4 \times 0.25]$
- Day 8: Operation 2, 1 hour consumed

**Order Modifiers**

The planning solver uses these rules to decide planned order sizes when there are conflicts between planning unit of work size and order modifiers:

- If fixed lot multiplier is higher than the planning unit of work size, use fixed lot multiplier.
- If minimum order quantity is higher than the planning unit of work size, use minimum order quantity.
- If maximum order quantity is lower than the planning unit of work size, use maximum order quantity.
- If there is a fixed order quantity, use it.
Responsibility and Menus

The seeded responsibility for Rapid Planning planners is Supply Chain Simulation Planner.

This responsibility can access these menus:

- Plans, Inputs, and Simulations: The Oracle Rapid Planning workbench.
- Collections, Sourcing, Setup, and Other: Forms appropriate to Oracle Rapid Planning from Oracle Advanced Supply Chain Planning. For information about these forms, see Oracle Advanced Supply Chain Planning Implementation and User’s Guide.

Rapid Planning Workbench

The Rapid Planning Workbench is a workspace designed with these characteristics:

- Simple to understand and easy to learn
- Access to lots of data
- Customizable data displays
- Quick entry of data changes for simulation

When you access Rapid Planning Workbench, you see the global region and a workspace region.

The top region has:

- Your user name
• Link Home: Returns to the e-Business Suite Rapid Planning responsibility menu
• Link Preferences: Set Oracle e-Business Suite preferences
• Link Help
• Link Logout
• Button Save: Saves your updates from all the tabs in the workbench. This is different from the Workbench Actions > Save Plan.

• Button Cancel: Discards your current updates and reverts to the last saved version of the plan.

The buttons to save and cancel changes apply to all tabs in the workspace. If you make changes in one tab and move to another tab, the Workbench prompts you to save your changes.

The workspace region contains:
• Tabs: Use these to view and manipulate the data. You can open as many multiple tabs as you need to accomplish your task. The Workspace region has top and bottom frames; they are independent places to open more tabs and are not related as in, for example, master-detail information.

• Links: Use these to manipulate the plans. You can hide this area; click icon Collapse Pane. To show it, click icon Restore Pane.

When you access Rapid Planner Workbench, The open tabs are:
• Plans
• Plan Inputs

The Plans contains a navigator on the left that contains three regions that you can access. They are:
• Plans: Displays a complete list of all the plans that are in the states Launched, completed and Loaded into memory; Launched and currently in-process; and Launched and errored out
• Plan Links: Contains links to workbench views that display data about the currently selected plan; you can take action against the data
• Plan Actions: Links to workbench views with actions that users need to manage the plans

The Plan Input tab displays a simpler navigator on the left that only has the Plan Input Links region. These links open views that you can use to see and update plan inputs and simulation set information.
Plan Availability for Update

When you select a plan in the Plans region, you can see its information. However, you can update plans only if they are loaded in to memory. To load a plan into memory, navigate to Plan Actions > Load Plan.
Using Workbench Tabs

Operating in Tabs

Rapid Planning Workbench is organized into multiple views in these main tabs:

- Plan Inputs
- Plans

As you open each view, there are these areas:

- Search
- Search results

These areas have common features that you work with.

If you want to make a tab disappear, click on its title, then click its icon Close.

This is an example of a workbench view
Search Area

The search area displays attributes that you can use to limit the display in the search results area. For example, in the Items tab, you can search for Item, Organization, Category, Product Family Item, Planner, Last Update Date, and Changed By.

Fill up the search fields that you want to, then click button Search.

If you search on more than one criteria, the search process treats them as if they are joined by logical operator AND. For example, you search on

- Item Equals AS54888
- Organization Equals M1

The search process finds everywhere in the data that Item Equals AS54888 AND Organization Equals M1

The search area shows Basic search fields. If you want to do a more advanced search, click button Advanced. The search area shows more fields to search on and shows button Basic to return to the basic search criteria.

If the advanced search does not contain all the fields that you want to search on, click button Add Fields and select them from the list.

To clear all the search criteria, click button Reset.

Search Results Area

The search results area shows the data that matches your search.
• Change how the data displays

• Act on the data

There are some common functions that appear in many views. See Search Results Area – Displaying Data and Search Results Area – Acting on Data.

Some functions in the search results area are unique for certain tabs. See Rapid Planning Workbench Views, page 4-12

**Search Results Area – Displaying Data**

You may see some or all of these menu items on the data area menu bar:

• Actions

• View

• Format

In addition, you may see icons and buttons on the search results menu bar.

If you want to see the data in a Microsoft Excel spreadsheet, click Actions > Export to Excel or click button Export to Excel. The export includes the column headings.

If you want to see the data printed out, click Actions > Print Page. A pop-up window opens with the data in a printable page format.

To sort the data by a certain column, mouse over the column title and select either icon Sort Ascending or icon Sort Descending. Also, you can click View > Sort > Ascending or View > Sort > Descending.

To sort on multiple columns, click View > Sort > Advanced… In the advanced sort pop-up window, select up to three column names and whether each should sort by.

To change the order of the columns, click View > Reorder Columns…. A pop-up window shows the available columns. To move a column positions, click the columns’ name in the pop-up window and then click one of these icons:

• Move selected items to top of list

• Move selected items up one in list

• Move selected items down one in list

• Move selected items to bottom of list

To change the size of columns, click Format > Resize Columns.

To wrap the data in the columns, click the Wrap icon or select Format > Wrap.

To make a column disappear, click View > Columns and click the columns to disappear.
If you want to add a new column, click View > Columns > Show More Columns. Then click the columns you want to see.

If you want to display all the columns available for the tab, click View > Columns > Show All

To move up in a chain of data, for example, a supply chain bill or pegging tree:

- To the original top level where used, click icon Go top
- To the next level where used, click Go up

To make the currently selected row the new top level, click Show as top. To return the display to the original top level where used, click on the new top level, then click either icon Go up or icon Go top.

If you want to freeze columns, click in a column, then click icon Freeze or click View > Freeze. The column that you selected and all columns to its left freeze while you can scroll through the columns to its right.

If you want to open the data area in a separate window of its own, click icon Detach. To resume working in the tab, click icon Attach. Use this function if you need to see a large number of data rows.

To search using the query-by-example method, click icon Find or click View > Query by Example. A blank row appears above the column titles. Enter your search criteria there. Click icon Query by example or click View > Query by Example again to execute the search. This function only works with fields that Oracle enables as query-by-example fields.

In some tabs, Oracle assigns multiple, related columns into column groups. If you want to see the columns arranged by their groupings, select View > Column Groups. For example, in tab Supply & Demand, the column groups are Main, Release, and Other.

If you want to open a tab with data that is related to the data you are viewing, select rows in the data area, then click a button with the name of another tab.

Sometimes, there are more buttons with the names of other tabs that do not fit in the current tab. Click icon double-greater than and select them from the list of buttons.

Search Results Area – Acting on Data

If you want to copy a data to new rows:

- Highlight the rows that you want copied
- Click the Duplicate icon or click Actions > Duplicate Selected

If you want to delete a row of data:

- Highlight the rows that you want deleted
Click the Delete icon or click Actions > Delete Selected

Specify a simulation set, see Managing Simulation Sets, page 4-6.

The deleted data remains displayed. It is in red with a strikethrough and the change flag is red.

You cannot delete certain entities, for example, items.

To add a row, click icon Add Row

To edit a row, either:
- Double-click in it
- Click in it then click icon Edit

Then, enter or select the new value into the field

To change individual data, click in the field and type in the new data.

To edit multiple rows (mass update), click in them using the Shift and Ctrl keys. To select all rows, click Actions > Select All or click icon Select All

To unselect a selected row, click in it.

To unselect all selected rows, click in an area of the tab that is not a selected row

Mass Updating

To edit one column (mass update):
- Use search criteria or a favorite to limit the display to the rows that you want to change
- Click the column header

To edit multiple columns (mass update):
- Use search criteria or a favorite to limit the display to the rows that you want to change
- Click the column headers using the Shift and Ctrl keys or rubber banding

Click icon Mass change or navigate Actions > Update Selected

The tab opens window Update Data. In each row, select a field and an update action, then enter a new value. Each update applies to all the rows you selected.

Saving and Committing

If want to save all your changes, click Actions > Update All.

If you want to save some your changes:
- Highlight the rows that you want changes saved
• Click Actions > Update Selected

After you change data:
• It appears in blue highlight
• There is a flag that appears in the left column to show the rows that are changed.

If you want to apply your changes to the database, click button Commit or click Actions > Commit. To reverse the commit, click button Rollback.

If you want to reverse the changes you have made:
• Highlight them
• Navigate to Plan Actions > Undo All User Changes

Managing Simulation Sets

After the collected data arrives, you can use it unchanged to run through a plan.

You can change it as changes in your manufacturing environment occur by individually updating or mass updating a plan or a copy of a plan. You do not have to make the changes in the source system and re-collect them.

You can use these changes to visualize your supply and demand picture:
• Before: A current plan
• After: A simulation plan that includes the simulated data. This can be a copy of the current plan.

Use simulation sets with a completed plan to augment collected data with new, changed, and deleted attributes that you want to store. After you store your changes in a simulation set, you can apply it at any time to this plan.

You do not need to store your changes in a simulation set for them to be used by a plan run. If you make individual updates and mass updates to a plan and run it, the planning solver uses your changes. If you save them in a simulation set, you can apply them again later to the plan.

Entities in Simulation Sets

These are the entities that you can change and save in simulation sets:
• Resources
• Resource Availability
• Bill of Materials
• Calendars

To change these entities, make changes directly in the data area tabs each time you need to simulate:

• Resource Availability

• Manufacturing Order Resource Requirements

• Supply and Demand

Working with Simulation Sets

You can begin to work with simulation sets by navigating to a data area tab, for example, Items. When you arrive there:

• There is an entry in tab Plan Inputs, Manage Simulation Sets

• The column Simulation Set has value Collected Data. If the tab has changed rows that you saved in a simulation set, that column shows the simulation set name.

• Simulation Set is a criterion in the search area. All of the rows of the tab display and the simulation set rows are in blue highlight.

To make a new simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, click icon Add New

• In the new blank row, enter the new simulation set name

To rename a simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, select the row with the name of the simulation set to rename

• Type the new name in the same row

To make a copy of a simulation set:

• Click Manage Simulation Sets

• In window Manage Simulation Sets, select the row with the name of the simulation set to make a copy of

• Click icon Duplicate

• The copied simulation set appears with name Duplicate of <original simulation set>
You can set a simulation set as a default. Every time you make a mass change, the Update Data window:

- Applies the default simulation set to the data
- Fills field Simulation Set with the default simulation set name. The mass update changes will go to the default simulation set unless you select another simulation set name before you OK the mass change

When you add or duplicate a row in a tab and want to store it in a simulation set, select the simulation set that you want as the value for column Simulation Set.

You can perform a mass update that includes rows from the simulation set:

- If you want to save these latest changes in a simulation set, when you are in window Update Data for the mass change, click button Manage Simulation Sets
- Changed data appears in new rows
- You can change changed data in an individual update but not in another mass update

You can delete rows from a simulation set just as you can from the collected data.

You may save changes in a simulation set, recollect the data, and then apply the simulation set to the recollected data. There can be changes in the simulation set that changed a row from the previous collection, but that row is not in the current collection. The tab displays these simulation set changes as deleted rows (red text with strikethrough and a red flag).

To delete a new simulation set:

- Click Manage Simulation Sets
- In window Manage Simulation Sets, select the row with the name of the simulation set to delete
- Click icon Delete

**Applying Simulation Sets**

You can apply one simulation set to a plan for each run.

When you want to apply a simulation set to a plan, enter its name in plan option Simulation Set.

The planning solver applies all the simulation set changes to the plan data before it begins solving supply and demand.

When the plan finishes, you can see the simulation set entities in the data area tabs as new rows.
Multi-planner Collaboration

Use multi-planner collaboration if:

- Your business has multiple planners
- They work independently on different parts of the plan
- They each want to easily save their changes either together or separately

Saving to Simulation Sets

Each planner can save their changes to a simulation set.

If you don't select any changed records, all your changes go into the simulation set. If you select changed records, only those changes go into the simulation set.

Use view action Save to Set or menu Plan Actions > Save to Simulation Set:

You can perform all the simulation set actions.

If you can update an entity in the views, you can save the entity to a simulation set.

If you change a field in a record, the save process saves the entire records, not just the field that changed. When the plan runs and applies the simulation set, it applies all fields from the last chronological update of the record.

When two planners update the same record at different times, the second updater's view may not display the field updates of the first updater. If so, the planning solver loses the first updater's field changes when it applies the second updater's record.

Simulation Set Configuration

All planners can save their changes to one simulation set. If multiple planners change the same information, the planning solver uses the last chronological change. Use this method if you want to consolidate all changes to apply to the next run of the plan.

Each planner can save their changes to different simulation sets. Use this method if each planner wants to run independent simulation on their part of the plan.

Planners can save changes from multiple plans to the same simulation set. Use this method if planners are working with copies of the base plan but want to save changes to apply in the next run of the base plans.

Multi-planner Example

This table shows a collected engineering change order cut-over in tab Plan Inputs:

<table>
<thead>
<tr>
<th>Simulation Set</th>
<th>End Item</th>
<th>Component</th>
<th>Effective Start</th>
<th>Effective End</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collected Data</td>
<td>AS66311</td>
<td>CM66331</td>
<td>-</td>
<td>Jan 7</td>
</tr>
</tbody>
</table>
The planner does some simulations, decides that a later cut-over is better, and enters that decision in the Bill of Materials view. The planner saves the changes to simulation set MySimSet. The data in tab Plan Inputs changes.
### Simulation Set End Item Component Effective Start Effective End Last Updated By Last Updated Date and Time

<table>
<thead>
<tr>
<th>Simulation Set</th>
<th>End Item</th>
<th>Component</th>
<th>Effective Start</th>
<th>Effective End</th>
<th>Last Updated By</th>
<th>Last Updated Date and Time</th>
</tr>
</thead>
<tbody>
<tr>
<td>Collected Data</td>
<td>AS66311</td>
<td>CM66331N</td>
<td>Jan 8</td>
<td>-</td>
<td>Planner 1</td>
<td>09/12/08 00:00</td>
</tr>
<tr>
<td>Collected Data</td>
<td>AS66311</td>
<td>CM11222</td>
<td>-</td>
<td>Jan 15</td>
<td>Planner 1</td>
<td>09/12/08 00:00</td>
</tr>
<tr>
<td>Collected Data</td>
<td>AS66311</td>
<td>CM11222</td>
<td>Jan 16</td>
<td>-</td>
<td>Planner 1</td>
<td>09/12/08 00:00</td>
</tr>
<tr>
<td>MySimSet</td>
<td>AS66311</td>
<td>CM66331</td>
<td>-</td>
<td>Jan 31</td>
<td>Planner 1</td>
<td>09/12/08 00:10</td>
</tr>
<tr>
<td>MySimSet</td>
<td>AS66311</td>
<td>CM66331N</td>
<td>Feb 1</td>
<td>-</td>
<td>Planner 1</td>
<td>09/12/08 00:10</td>
</tr>
<tr>
<td>MySimSet</td>
<td>AS66311</td>
<td>CM11222</td>
<td>-</td>
<td>Feb 14</td>
<td>Planner 2</td>
<td>09/12/08 00:20</td>
</tr>
<tr>
<td>MySimSet</td>
<td>AS66311</td>
<td>CM11222N</td>
<td>Feb 15</td>
<td>-</td>
<td>Planner 2</td>
<td>09/12/08 00:10</td>
</tr>
</tbody>
</table>

However, if the other planner saves changes to the same data that the original planner saved changes to, the simulation set only keeps the changes from the other planner.
Rapid Planning Workbench Views

Use the views to view, analyze, and update the plan information.

Access them from the Plan links section in the Plan tab and the Plan input links in the Plan inputs tab.

For each view, this tells you:

- The view name
- The regions that it commonly appears in
- What it is for and how to use it

Analytics

Most tabs share common functions, see Operating in Tabs, page 4-1.

Use this tab to view base metrics. See Rapid Planning Metrics Overview, page 5-13.

You cannot edit data in this view.

To view exception messages for a plan, load it.

Metrics Tab

You can create metrics from the list of available metrics. Specify the

- Dimensions, for example, item-organization
- Aggregation levels, for example, day or week
- Entities, for example, items and item categories
You can:

- View the results in graphs, for example, bar and line, and tables
- Specify the location of the metric on the metrics page, for example, left upper or right bottom
- See multiple metrics simultaneously
- Compare metrics across multiple plans or multiple runs of the same plan, for example, previous run and current run

Order Comparison Tab

You can compare across sales order demands between two plans. You cannot compare forecast demands.

The comparison type describes the satisfaction status of the demand in the base plan (Was…) and the compared plan (…, now…) For example, Was late, now on time.

Bills of Materials

Most tabs share common functions, see Operating in Tabs, page 4-1.

Use this tab to view bills of material.

You can edit data in this view.

Plan Tab

Search, view, and analyze the bills of material, components, and substitute components used in the plan.

Plan Inputs Tab

Add a bill of material or some of its components or substitutes to a simulation set.

Plan Tab and Plan Inputs Tab

Duplicate a bill of material, a component, or a substitute and make edits for simulation purposes

Mass edit a set of rows, for example, all assemblies that use a particular component and do a single-row edit to these attributes:

- Component effectivity date
- Component disable date
- Component
- Substitute component
- Component usage quantity
• Component yield
• Substitute priority
• Substitute quantity
• Substitute item UOM

Calendar Association
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view the associations of ship methods and calendars.
You cannot edit data in this view.

Plan Inputs Tab
Search, view, and analyze the associations of calendars to organizations, suppliers,
customers, and carriers.

Calendars
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view calendars.
You can edit data in this view.

Plan Inputs Tab
Search, view, and analyze the working days and non-working days of any calendar.
You can edit attribute Status (working or non-working) for simulation purposes in
simulation sets

Constraint Details
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to see constraints for late and unmet demands.
You can access it for single and multiple demands and from:
• Supply & Demand View: From Late or Unmet End Demands
• Exceptions View: From exception messages Late Replenishment for Forecast, Late
Replenishment for Sales Order, and Demand Quantity not Satisfied

You can see information in any planning mode, but the information is most relevant in
mode Constrained – Enforce capacity constraints.
Information appears here when the planning solver cannot wholly satisfy a demand due to any of these conditions:

- Material Constraint: Lead Time
- Material Constraint: Planning Time Fence
- Material Constraint: Date Effectivity
- Material Constraint: WIP Window
- Resource Constraint
- Supplier Constraint

Here are some specific field definitions:

- BOM Level: Bill of material level from the finished good; the finished good level is level 1.
- Constraint Type: Material, Resource or Supplier
- Material Constraint Type: Lead Time, Time Fence, Date Effectivity, WIP Window
- Requested Date: Date of the constraint
- Requested Qty: Quantity required to meet the demand on time; units for material or supplier constraints, hours for resource constraints.
- Available Qty: Quantity available at the moment that the planning solver is planning this demand
- Shortage Qty: Requested Qty – Available Qty
- Shortage %: Shortage Qty / Requested Qty

**Operational Considerations**

The planning solver reports only the root constraint and does not also report on the bill of material levels between the constraint and the finished good. For example:

- A finished good bill of material contains a subassembly.
- A component of the subassembly has a lead time constraint that makes the finished good satisfied late.
- The planning solver reports that the component has a constraint but does not report that the subassembly has a constraint.

The planning server does not report constraints that result in partially satisfied
demands that are on time. For example:

- It can only partially satisfy a demand on time because of a lead time constraint. It does not report this as a constraint in this tab.

- It can satisfy the remaining demand quantity late because of the lead time constraint. It does report this as a constraint in this tab.

The planning solver can sometimes choose from several ways to satisfy a demand. Sometimes all of the ways have constraints that result in satisfying the demand late. The planning solver uses the way that makes the least lateness and reports that as the constraint. For example:

- A distribution center has demand for a finished good.

- The sourcing for the finished good is from manufacturing organization A with rank 1 and manufacturing organization B with rank 2.

- It tries to satisfy demand from the rank 1 organization. It can satisfy the quantity but two days late.

- Since the rank 1 organization satisfies the demand late, the planning solver tries to satisfy demand from the rank 2 organization. It can satisfy the quantity but three days late.

- The planning solver plans to satisfy the demand from the rank 1 organization because it is less late (not because it is the rank 1 source). It reports the constraint against the rank 1 organization.

- It does not report the constraint against the rank 2 organization because it does not select that option.

Sometimes, the report of a lead time material constraint is actually caused by resource unavailability. For example:

- A resource is not available on the day the planning solver needs it to complete a component.

- The resource is available earlier.

- The planning solver plans to use the resource earlier.

- Using the resource earlier causes a lead time material constraint on the component, because work on the component is scheduled to start in the past.

- The planning solver reports a lead time material constraint against the component and does not report a resource constraint against the resource. However, the resource availability is the root cause of the late demand
• You can detect this situation by looking at the Pegging View and searching for time gaps.

**Clear to Build Workbench**

Use the Clear to Build Workbench to influence the allocation of clear to build on hand inventory. Prioritize and deprioritize make orders and sales orders.

The Clear to Build Workbench would have these regions:

• A region to search and view make orders

• A region to prioritize make orders for clear to build, view contentions (make orders that share common components with other make orders), and deprioritize make orders for clear to build

The search area has these searchable attributes:

• Item

• Organization

• Component Item

• Order Type

• Due Date

• End pegged Demand Customer

• End Pegged Demand Due Date

• Resource Used

• Clear to Build Status

• Clear to Build Date

• Clear to Build Component Available %

• Ready to Build %

The Make Orders table has all the searchable fields and also:

• Order Number

• Maximum Potential Ready to Build %

• Clear to Build Priority
• Deprioritized from Clear to Build

**Exceptions**

Most tabs share common functions, see Operating in Tabs, page 4-1. Use this tab to view exception messages.

You cannot edit data in this view.

You can set up the exceptions that you want to see:

• Click on Exceptions > Set Up

• Select the exceptions that you want to see by moving them between the lists using the >, >> and <,<< icons in the set up wizard

• Once you move an exception is moved from one list to another, it is removed from the original list.

• Use the up and down icons to specify the order of the exceptions display

To see exception messages, you must load the plan to your workspace.

Each exception message appears in a separate sub-tab. Each sub-tab has its own search area and search results area.

The exception message sub-tabs appear in the order that you set up. Several sub-tabs appear when you first see this tab.

To see another exception message sub-tab, click on the sub-tab related to the exception. If the exception you want is not visible, click icon double-greater than and select it.
exception from the drop down list.
To move around to other exception messages, click icons double-greater than and double-less than and select them.

You can:

- Save the search criteria for each exception
- Export exceptions to Microsoft Excel
- Specify search conditions to limit the display of each exception and save it. After you specify the search criteria, you can drill down to other views

The meaning of each exception message is in Exceptions > Rapid Planning Exceptions Overview.

**Items**

Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view item attributes.
You can edit data in this tab.

**Plan Tab**
Search, view, and analyze the items used in the plan

**Plan Inputs Tab**
Make changes to items and add them to a simulation set

**Plan Tab and Plan Inputs Tab**
Mass edit a set of rows, for example, all items of a particular category, or do a single-row edit to update any of these attributes

- Maximum Order Quantity
- Minimum Order Quantity
- Fixed Lot Multiple
- Fixed Order Quantity
- Variable Lead Time
- Fixed Lead Time
- Preprocessing Lead Time
- Processing Lead Time
- Postprocessing Lead Time
- Acceptable Early Days
- No New Planned Orders Before WIP

**Material Plan**

Most tabs share common functions, see Operating in Tabs, page 4-1.

Use this tab to view a horizontal picture of the supply and demand. It is a horizontal plan.

You can edit data in this view.

**Plan Tab**

To drill down to supply and demand detail, highlight cells, then click button Supplies & Demands

The time bucket dates appear as the first three rows of the display. To:

- Expand a time bucket into lower level buckets, click icon Drill Expand near the date of the higher-level bucket
- Summarize lower level bucket detail into the higher level bucket, click icon Drill Collapse near the date of the higher-level bucket

Click button Setup to see the Search and Layout window where you can:

- Specify filter criteria (tab Filters)
• Specify the layout of the data columns (tab Layout)

• Specify titles for the data columns (tab Labels)

• Save the search, layout, and titles and make it your default (tab General)

You can filter on:

• Category

• Item

• Projected available balance

• Organization

• Product family

You can directly make edits to the following row types:

• Forecasts

• Planned orders

• Manual demands

You can create:

• Planned orders

• Manual demands

After you save a changed cell, the tab:

• Finds the increased or decreased percentage change between what was there and what you changed it to

• Applies that to all supply or demand details that make up the number in that cell

• Sets the new quantity and date values as firm

For example, you have a material plan row

<table>
<thead>
<tr>
<th>Organization</th>
<th>Category</th>
<th>Measure</th>
<th>16 February</th>
<th>23 February</th>
<th>2 March</th>
</tr>
</thead>
<tbody>
<tr>
<td>TST_M1</td>
<td>Hard Drives</td>
<td>Forecast</td>
<td>2000</td>
<td>2400</td>
<td>3000</td>
</tr>
</tbody>
</table>

The bucket 23 February quantity 2400 is the sum of these detail forecasts.
You update bucket 23 February to quantity 3000.

The tab calculates a 25% quantity increase, passes that increase to all of the detail forecast firm quantities, and sets their firm dates.

If you are creating a supply or demand in a week or period bucket, the new supply or demand’s firm date is the last workday of the week or period.

Measures

You can view most of these measures as low as the item, organization, and day levels. You can roll up to higher levels category, product family, weeks, periods, and plan.

These are the demand measures available in the material plan:
• Dependent Demand: Sum of order types – (Planned order demand + Discrete job demand)

• Expected Scrap: Sum of Expected scrap; demand resulting from applying item attribute

• Shrinkage Rate to supplies

• Forecast: Forecast quantity after consumption

• Gross Requirements: Sum of all demands

• Manual Demand: Sum of manually created demand rows

• Other Independent Demand: Sum of (Hard reservation, Copied schedule demand, Non-standard demand, Demand class consumption)

• Production Forecast: Sum Production forecasts; can be based on exploded forecasts of product families and models

• Sales Orders: Sum of Sales order quantities

These are the supply measures available in the material plan:

• Current Scheduled Receipts: Sum of (Discrete jobs, Purchase orders, Requisitions, In transit, In receiving)

• Flow Schedules: Sum of Flow schedules

• In Receiving: Sum of In-receiving

• In Transit: Sum of In-transit

• Onhand: On-hand balance

• Planned Orders: Sum of Planned orders

• Purchase Orders: Sum of Purchase Orders

• Requisitions: Sum of Requisitions

• Total Supply: Sum of all supplies

• Work Orders: Sum of Discrete jobs

These are the other metrics available in the material plan:

• Projected Available Balance: Onhand + Total Supply – Gross Requirements
• Projected Onhand: Onhand + (Total Supply – Planned Orders) – Gross Requirements

Resource Availability

Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view resource availability.
You can edit data in this view.

Plan Tab
Search, view, analyze, and edit the resource availability used in the plan

Plan Inputs Tab
Add simulation set changes or manual over-rides on resource availability

Plan Tab and Plan Inputs Tab
Mass edit a set of rows, for example, all dates of a particular resource, or do a single-row edit to update any of the following attributes
• Shift Date
• Assigned Units
• Start Time
• End Time

Resource Plan

Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view a horizontal picture of the resources.
You can edit data in this view.
Plan Tab

To drill down to resource detail, highlight cells, then click button Resource Requirements.

The time bucket dates appear as the first three rows of the display. To:

• Expand a time bucket into lower level buckets, click icon Drill Expand near the date of the higher-level bucket

• Summarize lower level bucket detail into the higher level bucket, click icon Drill Collapse near the date of the higher-level bucket

Click button Setup to see the Search and Layout window where you can:

• Specify filter criteria (tab Filters)

• Specify the layout of the data columns (tab Layout)

• Specify titles for the data columns (tab Labels)

• Save the search, layout, and titles and make it your default (tab General)

You can filter on:

• Organization

• Resource

• Department
• Load Ratio

**Measures**
These are the measures available in the resource plan.
• Capacity load ratio
• Cum capacity load ratio
• Cum hours available
• Flow schedules
• Hours available
• Net ATP
• Net hours available
• Non-standard job orders
• Planned orders
• Required hours
• Run hours
• Run hour ratio
• Setup hours
• Setup hour ratio
• Sum of capacity changes
• Total resource cost
• Work orders

**Resource Requirements**
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view resource requirements.
You cannot edit data in this view.

**Plan Tab**
You cannot firm or reschedule the resource requirements for simulation purposes
Plan Inputs Tab
You cannot make changes or add simulation changes on the resource requirements

Plan Tab and Plan Inputs Tab
Search, view, and analyze the resource requirements in the plan

Resources
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view resource attributes.
You can edit data in this view.

Plan Tab
Search, view, analyze, and edit the resources in the plan

Plan Inputs Tab
Search, view, analyze, and edit the resources in the plan and add resource changes to a simulation set

Plan Tab and Plan Inputs Tab
Mass edit a set of rows or do a single-row edit to update attribute Bottleneck Resource flag.

Suppliers
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view supplier attributes.
You cannot edit data in this view.

Plan Tab and Plan Inputs Tab
Search, view, and analyze the approved supplier lists and the supplier capacities used in the plan
You cannot edit any of the attributes nor add them to simulation sets

Supply & Demand
Most tabs share common functions, see Operating in Tabs, page 4-1.
Use this tab to view supply and demand for an item-organization combination.
You can edit data in this view.
It displays as a collection of trees with the pegging information collapsed under each supply or demand line. The pegging is based on the assignments that the planning solver made in its last replan.

Since the tab is a combined supply-demand display and a pegging tree, a supply or demand could appear multiple times, due to, for example:

- A supply pegged to multiple top-level demands
- Once as a root node as returned by search criteria and once as part of the pegging chain of another demand or supply

To expand all nodes completely, click Actions > Expand All

This view shows a list of column groups in the search results area.

You can set the display to show:

- All: All columns
- Main: The major columns
- Release: Columns related to releasing
- Other: Other columns

To change the upstream (supply) or downstream (demand) orientation of the pegging tree, click toggle icon Supply/Demand Pegging or click Actions > Supply Pegging and Actions > Demand Pegging. In

- Supply pegging mode, the display begins with the top level demand and proceeds
to the lowest level supplies

- Demand pegging mode, the display begins with the lowest level supply and proceeds to the top level demands

When viewing a demand's upstream (supply) pegging, if you want to see only the supplies that have exceptions, click Actions > Exceptions. To cancel, click it again.

When viewing a supply's downstream (demand) pegging, if you want to see only the end demands that a supply pegs to and none of the intermediate levels:
- Select the supply
- Click Actions > End Demands
- To cancel, click it again

The tab always hides these demand pegging rows:
- Transfer dependent demand
- Component dependent demand

The pegging tree shows the downstream supply pegged to the upstream supply.

The tab always hides these routing pegging rows:
- Operations for work orders
- Resource requirements for planned orders and work orders

You can click icon Add Row to add:
- Supply of type Planned order
- Demand of type Manual MDS

To delete a supply or demand that you have entered, click icon Delete Row before you save the row.

The fields that you can edit in each row depend on:
- Whether it is a supply or a demand
- Its order type

Since different fields apply to each order type, Oracle recommends that you perform mass updates on only one order type at a time. If the tab cannot update all selected records with the change that you want, it pops-up an error page that shows the fields and the rows that it cannot update with the new values.

**Plan Tab**
Mass edit a set of rows, for example, priority of all orders from a customer, or do a single-row edit to update any of the following attributes for simulation purposes:

- Firm Status
- Firm Date
- Firm Quantity
- Alternate BOM
- Alternate Routing
- Source Organization
- Source Supplier
- Source Supplier Site

**Plan Inputs Tab**

You cannot edit the supplies and demands and cannot add them to simulation sets.

**Plan Tab and Plan Inputs Tab**

Search, view, analyze, and edit the supplies and demands in the plan.

**Order Types**

These are the demand order types that Oracle Rapid Planning works with:

- Flow schedule demand
- Flow schedule scrap
- Intransit shipment scrap
- Manual forecast
- Non-standard job demand
- Other independent demand
- Planned order demand
- Planned order scrap
- Production Forecast
- Purchase order scrap
- Purchase requisition scrap
• Sales orders
• Work order scrap
• Work order demand

These are the supply order types that Oracle Rapid Planning works with:
• Demand class consumption
• Flow schedule
• Flow schedule by-product
• Intransit receipt
• Intransit shipment
• Non-standard job
• Nonstandard job by-product
• On hand
• PO acknowledgment
• PO in receiving
• Planned order
• Planned order co-product/by-product
• Purchase order
• Purchase requisition
• Supply adjustment
• Work order
• Work order co-product/by-product

**Firming**

You need to firm planned orders before you can process any simulation changes; click the planned orders to firm, then click Actions > Firm. However, you can release planned orders that are not firm.

You can also firm:
• Work orders
• Purchase requisitions
• Purchase orders
• Forecasts
• Sales orders

Attend to these fields for all firming:
• Firm Status
• Firm Date
• Firm Quantity

In addition, attend to these additional fields for these specific order types:
• Planned order: Alternate BOM, Alternate Routing, Source Organization, Source Supplier, Source Supplier Site
• Work order: <no additional fields>
• Purchase order and purchase requisition: <no additional fields>
• Forecast and sales order: Order Priority

**Releasing**

You can release order type planned orders in the workbench

Before you can release them, perform some setup steps; see Deployment, page 7-1 > Releasing Planned Orders.

These are the order types that you can reschedule in the Workbench:
• Purchase orders
• Requisitions
• Work orders
• Sales orders

These are the order types that you can cancel in the Workbench:
• Purchase orders
• Requisitions
• Work orders

To mark an order for release, click Actions > Mark for release.
For planned orders, attend to these fields prior to release:
• Implement Quantity
• Implement Alt BOM
• Implement Alt Routing
• Implement As
• Implement Date
• Implement Demand Class
• Implement Firm
• Implement Job
• Implement Status
• Implement Supplier
• Implement Supplier Site
• Implement WIP Class

For work orders, attend to these fields prior to release:
• Implement Quantity
• Implement Alt BOM
• Implement Alt Routing
• Implement As
• Implement Date
• Implement Firm
• Implement Job
• Implement Status
• Implement WIP Class
For requisitions and purchase orders, attend to these fields prior to release:

- Implement Quantity
- Implement As
- Implement Date
- Implement Firm
- Implement Job
- Implement Status
- Implement Supplier
- Implement Supplier Site

To release, see Rapid Planning Workbench Views, page 4-1 > Supply & Demand > Releasing.

To monitor the orders during release, use field Release Status of each order. This table shows the values that Release Status displays.

<table>
<thead>
<tr>
<th></th>
<th></th>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>None available</td>
<td>Ineligible</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>Release</td>
<td>Release</td>
<td>Marked for Release</td>
<td>Released</td>
</tr>
<tr>
<td>Reschedule</td>
<td>Reschedule</td>
<td>Marked for Reschedule</td>
<td>Rescheduled</td>
</tr>
<tr>
<td>Cancel</td>
<td>Cancel</td>
<td>Marked for Cancel</td>
<td>Cancelled</td>
</tr>
</tbody>
</table>

If you have marked an order for release, you may be able to unmark it for release. After you do, its Release Status returns to the value it had before you marked it for release (Release, Reschedule, or Cancel). Click Action > Unmark for release

**Inventory Reservations**

Column Reserved Quantity:

- Shows the quantity reserved from on hand against a sales order
- Displays a value only for sales orders
You cannot edit it.

If there is an inventory reservation, demand pegging for on hand displays, for sales orders:

- Reserved Quantity
- Pegged Qty: This can be lower than reserved quantity

In this example, sales order:

- 45678 shows a full reservation
- 12345 shows a partial reservation: The reserved and pegged quantities are different

<table>
<thead>
<tr>
<th>Item</th>
<th>Order Type</th>
<th>Order Number</th>
<th>Quantity</th>
<th>Reserved Quantity</th>
<th>Pegged Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>XYZ</td>
<td>On hand</td>
<td>-</td>
<td>1000</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>. XYZ</td>
<td>Sales order</td>
<td>12345</td>
<td>49</td>
<td>49</td>
<td>4</td>
</tr>
<tr>
<td>. XYZ</td>
<td>Sales order</td>
<td>45678</td>
<td>143</td>
<td>143</td>
<td>143</td>
</tr>
</tbody>
</table>

If there is an inventory reservation, supply pegging for on hand displays:

- For sales orders, Reserved Quantity
- For on hand, Pegged Quantity

In this example, sales order:

- 45678 shows a full reservation
- 12345 shows a partial reservation: There are two lines for pegged quantity, one for the partial reservation and one for the remaining quantity that can peg to any supply type.

<table>
<thead>
<tr>
<th>Item</th>
<th>Order Type</th>
<th>Order Number</th>
<th>Quantity</th>
<th>Reserved Quantity</th>
<th>Pegged Quantity</th>
</tr>
</thead>
<tbody>
<tr>
<td>XYZ</td>
<td>Sales order</td>
<td>12345</td>
<td>49</td>
<td>19</td>
<td>-</td>
</tr>
<tr>
<td>. XYZ</td>
<td>On hand</td>
<td>-</td>
<td>1000</td>
<td>-</td>
<td>19</td>
</tr>
</tbody>
</table>
The planning solver:

- Cancels the reservation if the on hand is no longer available
- Reduces the reservation if the sales order quantity is lower than the reservation

### Supply Chain Bill

Most tabs share common functions, see Operating in Tabs, page 4-1.

Use this tab to view a graphical and tabular supply chain bill.

You can edit data in this view.

The supply chain bill is a nested tree of the:

- Component structure: For all effectivity dates
- Sourcing hierarchy: This is from the assignment set of the plan options

There is not a separate row in the supply chain bill for Make at or Transfer from sourcing. There is a separate row for Buy from sourcing.

The tab shows all alternate bills of material unless you restrict it through search field Alternate BOM.

The tab does not show substitute components.

To add a component to an assembly:

- Click one assembly only
- Click icon Add Component

To add a component to an assembly by duplicating another component:

- Click one component only
- Click icon Duplicate Component
• Use line editing to change the duplicated component row

To remove a component from an assembly:

• Click one assembly only

• Click icon Remove Component

**Components Plan Tab**

Search, view, and analyze the complete supply chain of specific end assemblies and their bills of material and sourcing.

You cannot make any edits in this view for simulation purposes. You can use the Bill of Materials view to edit bill of material attributes.

**Processes Plan Tab and Processes Plan Inputs Tab**

Search, view, and analyze the routings, operations, and resources assigned to each operation

You cannot make any edits in this view for simulation.
Using Workbench Exceptions and Metrics

Exceptions Overview

Exception messages alert the planner to situations where the planning solver needs planner intervention.

These are the exception messages that the planning solver issues, see Exception Messages, page 5-2:

- Demand Quantity Not Satisfied
- Demand Satisfied Using End Item Substitution
- Items With a Shortage
- Items Below Safety Stock
- Items with Excess Inventory
- Late Replenishment for Forecast
- Late Replenishment for Sales Order
- Late Supply Pegged to Forecast
- Late Supply Pegged to Sales Order
- On Time Orders
- Order Sourced from Alternate Facility
- Order Sourced from Alternate Supplier
- Order with Insufficient Lead Time
- Orders to be Cancelled
- Orders to be Rescheduled In
- Orders to be Rescheduled Out
- Past Due Orders
- Past Due Sales Orders
- Planned Order Uses Alternate BOM/Routing
- Planned Order Uses Substitute Component
- Planned Order Uses Alternate Resource
- Resource Overloaded
- Sales Order/Forecast at Risk Due to a Resource Shortage
- Sales Order/Forecast at Risk Due to Material Shortage
- Supplier Capacity Overloaded

Exception Messages

These are explanations of the exception messages that the planning solver issues.

Demand Quantity Not Satisfied

For any demand pegged to supplies, the supply quantities are less than the demand quantity. The planning solver issues this exception message for demands at all levels of the supply chain bill of materials.

The planning solver delays the demand until the end of the planning horizon and issues this exception is there is no demand on the plan horizon end date.

This is some of the information displayed for this exception:
- Partial Planned Date: The date on which the order is partially planned
- Partial Planned Quantity: Quantity of the order that is planned on partial Planned date
- Quantity Mismatch: Quantity of the order that has not been planned; the shortage quantity, Demand quantity – Total pegged supply quantity
- Value of Order: Order quantity * Price
- Value of Order (Unplanned Portion): Unplanned order quantity * Price

**Demand Satisfied Using End Item Substitution**

The planning solver plans to satisfy an end item demand using a supply order with a substitute item. If it satisfies a demand with multiple planned orders, it issues an exception for each supply order with the substitute item.

For example, the substitution chain is PSS7001 > PSS7002 > PSS7003 > PSS7004. The planning solver can satisfy demand for:

- PSS7001 using PSS7002, PSS7003, or PSS7004
- PSS7002 using PSS7003 or PSS7004
- PSS7003 using PSS7004

The substitute quantity is from the item relationships.

A piece of the information displayed for this exception is Value of Order: Order quantity * Price.

**Items With a Shortage**

An item has negative projective available balance at the end of the planning bucket. In this example, the planning solver issues these Items With A Shortage exception messages:

- Projected available balance -50 units
- Days 5 & 6: Projected available balance -200 units on both days

<table>
<thead>
<tr>
<th></th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hand</td>
<td>0</td>
<td>50</td>
<td>-50</td>
<td>50</td>
<td>0</td>
<td>-200</td>
<td>-200</td>
</tr>
<tr>
<td>New Supply in bucket</td>
<td>100</td>
<td>0</td>
<td>200</td>
<td>50</td>
<td>100</td>
<td>0</td>
<td>200</td>
</tr>
<tr>
<td>Demand in bucket</td>
<td>50</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Projected Available Balance</td>
<td>50</td>
<td>-50</td>
<td>50</td>
<td>0</td>
<td>-200</td>
<td>-200</td>
<td>0</td>
</tr>
</tbody>
</table>
This is some of the information displayed for this exception:

- **From Date**: The start date of the first planning time bucket in which the item has a shortage.
- **To Date**: The start date of the last planning time bucket in which the item has a shortage.
- **Days of Shortage**: Number of workdays the item is short, based on the manufacturing calendar of the organization. As long the shortage quantity remains the same in successive planning time buckets, the planning solver issues one exception message and extends To Date.
- **Value of Shortage**: Shortage quantity * Item standard cost.

**Items Below Safety Stock**

Projected available balance for a planning bucket is below the specified safety stock level for the planning bucket.

Since Oracle Rapid Planning uses the period-of-cover safety stock basis, safety stock is the amount required to cover demand for the target days.

In this example, the planning solver issues these Items Below Safety Stock exception messages:

- **Day 2**: 50 \([300 – 250]\)
- **Day 3**: 250 \([500 – 250]\)

<table>
<thead>
<tr>
<th></th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hand</td>
<td>0</td>
<td>350</td>
<td>250</td>
<td>250</td>
<td>550</td>
<td>350</td>
<td>350</td>
</tr>
<tr>
<td>New Supply in bucket</td>
<td>400</td>
<td>0</td>
<td>100</td>
<td>400</td>
<td>100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Demand in bucket</td>
<td>50</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Safety Stock Target (Days)</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
</tbody>
</table>
This is some of the information displayed for this exception:

- **From Date**: The start date of the first planning time bucket in which the item is below safety stock.

- **To Date**: The start date of the last planning time bucket in which the item is below safety stock.

- **Projected Available Balance**: On To Date

- **Quantity Below Safety Stock**: Safety Stock Target (Quantity) – Projected Available Balance. As long the below safety stock quantity remains the same in successive planning time buckets, the planning solver issues one exception message and extends To Date.

- **Days of Shortage**: Number of workdays the item is below safety stock, based on the organization manufacturing calendar.

- **Value of Shortage**: Quantity below safety stock * Item standard cost

### Items With Excess Inventory

The projected available balance on a particular day exceeds Safety Stock Target (Quantity) for that day.

If you want to see only the exceptions above a certain threshold, specify the threshold in the search area on the Exceptions tab.

In this example, the planning solver issues these Items With Excess Inventory exception messages:

- **Day 1**: 100 [350 – 250]

- **Day 4**: 150 [550 – 400]
- Day 5: 50 [350 – 300]
- Day 6: 350 [350 – 0]
- Day 7: 350 [350 – 0]

<table>
<thead>
<tr>
<th></th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>On Hand</td>
<td>0</td>
<td>350</td>
<td>250</td>
<td>250</td>
<td>550</td>
<td>350</td>
<td>350</td>
</tr>
<tr>
<td>New Supply in</td>
<td>400</td>
<td>0</td>
<td>100</td>
<td>400</td>
<td>100</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>bucket</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Demand in bucket</td>
<td>50</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Safety Stock</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
<td>3</td>
</tr>
<tr>
<td>Target (Days)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Safety Stock</td>
<td>250</td>
<td>300</td>
<td>500</td>
<td>400</td>
<td>300</td>
<td>0</td>
<td>0</td>
</tr>
<tr>
<td>Target (Quantity)</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Projected</td>
<td>350</td>
<td>250</td>
<td>550</td>
<td>550</td>
<td>350</td>
<td>350</td>
<td>350</td>
</tr>
<tr>
<td>Available</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
<tr>
<td>Balance</td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
<td></td>
</tr>
</tbody>
</table>

This is some of the information displayed for this exception:

- From Date: The start date of the first planning time bucket in which the item has excess inventory
- To Date: The start date of the last planning time bucket in which the item has excess inventory.
- Projected Available Balance: On To Date
- Quantity of Excess: Projected Available Balance - Safety Stock Target (Quantity). As long the excess inventory quantity remains the same in successive planning time buckets, the planning solver issues one exception message and extends To Date
• Days of Excess: Number of workdays the item has excess inventory, based on the organization manufacturing calendar

• Value of Excess: Quantity of excess * Item standard cost

**Late Replenishment for Forecast**

The supplies for a forecast are due later than the forecast's due date. For example, there is a forecast for item A due 25 January for quantity 100 in organization D2. The supplies pegged to this sales order line are:

- Supply 1: Quantity 50 and due date 23 January
- Supply 2: Quantity 20 and due date 25 January
- Supply 3: Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3). Days late are 2. Quantity satisfied by forecast date is 70 (from Supply 1 and Supply 2).

This is some of the information displayed for this exception:

- Demand Date: The Requested Date of the forecast.
- Days Late: Difference between the Planned Date and the Demand Date, based on the manufacturing calendar of the organization
- Value of Forecast: Forecast Quantity * Price
- Value of Delay: Delayed quantity * Price

**Late Replenishment for Sales Order**

The supplies for a sales order line are due later than the sales order line’s schedule date. For example, there is a sales order line on item A, with a scheduled date of 25 January for quantity 100 in organization D2. The supplies pegged to this sales order line are:

- Supply 1: Quantity 50 and due date 23 January
- Supply 2: Quantity 20 and due date 25 January
- Supply 3: Quantity 30 and due date 27 January

Demand satisfied date is 27 January (from Supply 3). Days late are 2. Quantity satisfied by sales order line schedule date is 70 (from Supply 1 and Supply 2).

This is some of the information displayed for this exception:

- Demand Date: The Requested Date of the sales order.
• Days Late: Difference between the Planned Date and the Demand Date, based on the manufacturing calendar of the organization

• Value of Forecast: Sales Order Quantity * Price

• Value of Delay: Delayed quantity * Price

Late Supply Pegged to Forecast
A forecast demand will be satisfied late because supplies that peg to it are late.
This is some of the information displayed for this exception:
• Supply Order Demand Date: The date when the supply order should have been created to meet the forecast on time

• Supply Order Due Date: Actual supply date of the supply order

• Supply Days Late: Supply order demand date – Supply order due date, based on the organization manufacturing calendar of the demand

Late Supply Pegged to Sales Order
A sales order demand will be satisfied late because supplies that peg to it are late that is satisfied late.
This is some of the information displayed for this exception:
• Supply Order Demand Date: The date when the supply order should have been created to meet the forecast on time

• Supply Order Due Date: Actual supply date of the supply order

• Supply Days Late: Supply order demand date – Supply order due date, based on the organization manufacturing calendar of the demand

Order Sourced from Alternate Facility
The planning solver sources a planned order from an alternate facility
This is some of the information displayed for this exception:
• Source Org: The alternate facility

• Value of Order: Order quantity * Cost
**Order Sourced from Alternate Supplier**

The planning solver sources a planned order from an alternate supplier

This is some of the information displayed for this exception:

- Supplier: The alternate supplier
- Supplier site: The alternate supplier site
- Value of Order: Order quantity * Cost

**Order With Insufficient Lead Time**

The planning solver detects that a supply order needs to be completed in less time than the minimum processing time required to meet the demand. If the planning solver plans the order according to its lead-time, it would start in the past (before the planning horizon start date).

The planning solver issues this exception message only when an order start date is scheduled to be before the horizon start date. It never generates it when the plan start date is later than the horizon start date.

To calculate order start date, the planning solver uses the item lead time offset (for unconstrained plan) or routing level processing times (for constrained plans) and then backward schedules from its due date. It considers all the relevant calendars associated with each part of the supply chain model.

This is some of the information displayed for this exception:

- Compression Days: Number of days the order is compressed, based on the organization manufacturing calendar; Horizon Start – Order Start
- Value of Order: Order quantity * Item standard cost

**Orders to be Cancelled**

This exception message appears when the planning solver suggests that you cancel a supply order. It occurs when the planning solver detects a non-firm supply order that you do not need to satisfy demand or safety stock requirements.

A piece of the information displayed for this exception is Value of Order: Order quantity * Cost

**Orders to be Rescheduled In**

The planning solver suggests that you reschedule an existing supply order to an earlier date. It occurs when the planning solver detects a non-firm existing supply order with a due date that is later than it suggests (suggested order date). The planning solver
continues to plan lower bill of material levels as if you accept the suggestion.

This is some of the information displayed for this exception:

- **Order Number**: The start date of the planning time bucket in which the supplier capacity is overloaded
- **Original Due Date (From Date)**: The current due date
- **Suggested Due Date**: New due date that the planning solver recommends; no earlier than the plan horizon start date.
- **Reschedule Days**: Number of workdays between the original and suggested due dates, based on the organization manufacturing calendar.
- **Value of Order**: Quantity * Item standard cost

### Orders to be Rescheduled Out

The planning solver suggests that you reschedule an existing supply order to a later date. It occurs when the planning solver detects a non-firm existing supply order with a due date that is earlier than it suggests (suggested order date). The planning solver continues to plan lower bill of material levels as if you accept the suggestion.

This is some of the information displayed for this exception:

- **Order Number**: The start date of the planning time bucket in which the supplier capacity is overloaded
- **Original Due Date (From Date)**: The current due date
- **Suggested Due Date**: New due date that the planning solver recommends; no earlier than the plan horizon start date.
- **Reschedule Days**: Number of workdays between the original and suggested due dates, based on the organization manufacturing calendar.
- **Value of Order**: Quantity * Item standard cost

### Past Due Orders

Supply orders and planned orders have order (start) dates or due dates in the past (before the planning horizon start date).

For non-firmed supply orders, the planning solver also issues exception message Orders to be rescheduled out.

This is some of the information displayed for this exception:
• Order Number: The start date of the planning time bucket in which the supplier capacity is overloaded

• Suggested Due Date: No earlier than the plan horizon start date

• Days Past Due: Number of workdays past due, based on the organization manufacturing calendar; Due date – Horizon start date

• Value of Order: Quantity * Item standard cost

**Past Due Sales Orders**

The schedule date of the sales order line is earlier than the plan horizon start date.

This is some of the information displayed for this exception:

• Days Past Due: Number of workdays past due, based on the manufacturing calendar of the organization

• Value of Order: (Quantity on Sales Order * Price)

**Planned Order Uses Alternate BOM/Routing**

The planning engine uses an alternate bill of material or routing in a planned order or detects a firm planned order with an alternate bill of material or routing.

A piece of the information displayed for this exception is Order Value: Order quantity * Item standard cost

**Planned Order Uses Alternate Resource**

The planning engine uses an alternate resource in a planned order or detects a firm planned order with an alternate resource.

This is some of the information displayed for this exception:

• Quantity: Units of the primary and alternate resources used

• Value of Order: Order quantity * Item standard cost

• Resource units from alternate: Units of the alternate resource used

**Planned Order Uses Substitute Component**

The planning engine uses a substitute component in a planned order or detects a firm planned order with a substitute component.

A piece of the information displayed for this exception is Value of Order: Order quantity * Cost
Resource Overloaded

In a planning time bucket, the resource required capacity is more than the resource available capacity. Resources could be overloaded in constrained plans because of firm supplies that have associated resource consumption. In unconstrained plans, resources could be overloaded to meet demand requirements on time.

This is some of the information displayed for this exception:

- Start Constraint Date: Date that the overload starts
- End Constraint Date: Date that the overload ends
- Resource Load Ratio (%): (Resource requirement / Resource availability) * 100

Sales Order/Forecast at Risk Due to a Resource Shortage

Typically issued in an unconstrained plan when the sales order or forecast is still planned on time even in the absence of resource availability. This exception message details the end demands that are at risk because of being pegged to supply orders with resources with insufficient capacity.

Sales Order/Forecast at Risk Due to Material Shortage

Typically generated in an unconstrained plan when the sales order or forecast is still planned on time even in the absence of material availability (because of the plan being unconstrained). This exception details the end demands that are at risk because of being pegged to supply orders with material shortages.

Supplier Capacity Overloaded

In a planning time bucket, the supplier required capacity is more than the supplier available capacity.

The amount of overload is Required capacity of the bucket - Cumulative available capacity of the bucket. Load ratio is a percent and its calculation is (Required quantity / Cumulative available quantity) * 100.

The planning solver consumes supplier capacity is through backward then forward netting of capacity from the demand date. The calculation of supplier capacity utilization is Capacity consumed / Supplier capacity per day. The planning solver issues this exception message only on the days that have utilization over 100%.

In this example:
- Row Order Qty shows orders that use up the supplier capacity.
- Since supplier capacity is cumulative, the planning solver can consume more than
the capacity on a specific day. For example, on day D3, the planning solver can backward consume up to quantity 40

<table>
<thead>
<tr>
<th>-</th>
<th>Day 0</th>
<th>Day 1</th>
<th>Day 2</th>
<th>Day 3</th>
<th>Day 4</th>
<th>Day 5</th>
<th>Day 6</th>
<th>Day 7</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supplier Capacity</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>10</td>
</tr>
<tr>
<td>Order Quantity</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>40</td>
<td>-</td>
<td>-</td>
<td>-</td>
<td>30</td>
</tr>
<tr>
<td>Capacity Consumed</td>
<td>0</td>
<td>10</td>
<td>10</td>
<td>20</td>
<td>10</td>
<td>10</td>
<td>10</td>
<td>0</td>
</tr>
<tr>
<td>Utilization Percentage</td>
<td>0</td>
<td>100</td>
<td>100</td>
<td>200</td>
<td>100</td>
<td>100</td>
<td>100</td>
<td>0</td>
</tr>
</tbody>
</table>

Some of the information displayed for this exception is From Date: The start date of the first planning time bucket in which the supplier capacity is overloaded

Metrics Overview

Metrics are indicators of plan quality.

Base Metrics

The planning solver calculates these metrics based on data from the plan.

These are the base metrics that the planning solver calculates, see Base Metrics, page 5-14:

- Fill Rate
- Gross Margin %
- Inventory Turns
- Late Orders Ratio (count)
- Manufacturing Cost (functional currency)
• Purchasing Cost (functional currency)
• Resource Utilization %
• Revenues (functional currency)
• Stock Out Days
• Safety Stock Violation Days
• Supplier Capacity Utilization %

**Exception-Based Metrics**

The planning solver derives these metrics from exception messages, most often by aggregating facts associated with them related exceptions. These metrics include:

• The count: Number of the exceptions; for example, the number of exception message Past Due Orders that the planning solver issues in the plan run

• Quantity: Number of pieces involved in the exception; for example, shortage quantity

• Value: In functional currency of the exception; for example, the Quantity * Cost of exception messages Orders to be Rescheduled In

• Days: Duration of the exception; for example, days below safety stock represented by the exception messages Items Below Safety Stock

• Ratio: Ratio of exception occurrences to a baseline; for example; the supplier load ratio resulting from the exception messages Supplier Capacity Overloaded

**Base Metrics**

These are explanations of the base metrics that the planning solver calculates.

**Clear to Build Component Availability %**

This metric is relevant for Oracle Advanced Planning Command Center

The dimensional combinations are:

• All
• Item Category
• Organization
• Item Category-Organization
• Item-Organization
• Item Category-Organization-Week
• Item-Organization-Week

The percentage of component requirements that are fully available on-hand:
• Aggregated to the dimensions that you specify
• Over the clear to build horizon

The calculation is total component requirements vs component requirements in on-hand.

**Clear to Build Orders (%)**

This metric is relevant for Oracle Advanced Planning Command Center.

The dimensional combinations are:
• All
• Item Category
• Organization
• Item Category-Organization
• Item-Organization
• Item Category-Organization-Week
• Item-Organization-Week

The percentage of orders that are clear to build (have all their components completely pegged to on hand):
• Aggregated to the dimensions that you specify
• Over the clear to build horizon

The calculation is total make orders vs. make orders that are clear to build.

**Fill Rate (percentage)**

Fill rate of the end demands based on quantity satisfied on time. The planning solver calculates it at level Item-Organization-Customer-Site.
Total quantity satisfied on time / Total quantity of the demand

**Gross Margin % (percentage)**

Gross Margin % (percentage)

where

Total Cost = Manufacturing cost + Purchasing cost

The planning solver calculates this at level Item-Organization-Customer-Day. Day is the order Scheduled Ship Date.

**Inventory Turns (ratio)**

Annualized cost of goods sold in standard cost / Average projected available balance

where

Annualized cost of goods sole = (Item standard cost * Sum of [Independent demand quantity in plan * 365]) / Number of days in plan

Average projected available balance = Average of beginning value and ending value of each bucket

**Late Orders Ratio (count)**

Demand lateness measured as the percentage of the number of end demand lines unsatisfied on their due date.

**Manufacturing Cost (functional currency)**

Manufacturing cost value in functional currency

The standard costs collected into Rapid Planning are not rolled-up.

The planning solver calculates this at level Item-Organization-Day.

**On Time Orders (percentage)**

Percentage of on time demands, measured as the percentage of number of end demand lines unmet on due date

The planning solver calculates this at level Item-Organization-Customer-Day.

**Purchasing Cost (functional currency)**

Purchasing cost value in functional currency.

The planning solver calculates this at level Item-Organization-Supplier-Day.
Ready to Build %

This metric is relevant for Oracle Advanced Planning Command Center. The dimensional combinations are:

- All
- Item Category
- Organization
- Item Category-Organization
- Item-Organization
- Item Category-Organization-Week
- Item-Organization-Week

The percentage of orders that are ready to build (have all their components pegged to on hand, but not all their total quantities pegged):

- Aggregated to the dimensions that you specify
- Over the clear to build horizon

The calculation is total make orders vs make orders that are ready to build.

Resource Utilization % (percentage)

Resource utilization as a ratio of resource requirements to resource availability within the planning bucket.

The planning solver calculates this at level Resource-Organization-Day.

Revenues (functional currency)

Sum of [(Independent demand quantity * (List price - Discount)]

The planning solver calculates it at level Item category-Organization-Customer-Day. Day is the order Scheduled Ship Date.

Stock Out Days (days)

Total number of days stocked out
Safety Stock Violation Days (days)

The number of days when the inventory at the end of a planning bucket is below minimum safety stock targets.

The planning solver calculates it at level Item-Organization-Day.

Supplier Capacity Utilization % (percentage)

Ratio of supplier capacity required to supplier available capacity

The planning solver calculates this at level Item-Organization-Supplier-Day.

Top Shortage Components

The dimensional combination is Item-Organization

The percentage of orders that are ready to build (have all their components pegged to on hand, but not all their total quantities pegged):

The filter criteria for this metric must have filters for specifying the end item category, date range, items, and organizations.

The calculation is total pegged requirements for the component across all orders vs pegged requirements for the component across against non-on hand supply.

Top Shortage Suppliers

The dimensional combination is Item-Organization

The percentage of orders that are ready to build (have all their components pegged to on hand, but not all their total quantities pegged):

The filter criteria for this metric must have filters for specifying the end item category, date range, items, and organizations.

The calculation is total buy requirements against the supplier across all orders vs buy requirements against the supplier pegged against non-on hand supply.
Managing Plans

Workbench Actions

Each simulation plan goes through this life cycle.

<table>
<thead>
<tr>
<th>Action</th>
<th>Plan State</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Plan</td>
<td>Created</td>
</tr>
<tr>
<td>Launch Plan</td>
<td>Successfully launched</td>
</tr>
<tr>
<td>Load Plan</td>
<td>Loaded in memory</td>
</tr>
<tr>
<td>Close Plan</td>
<td>Not in memory; closed</td>
</tr>
<tr>
<td>Save Plan</td>
<td>Saved to database from memory</td>
</tr>
<tr>
<td>Delete Plan</td>
<td>Delete plan from memory and database</td>
</tr>
</tbody>
</table>

Use the actions to act against plans. You find links to the actions in the Plan Actions section of the navigator in the Plan inputs tab.

For each action, this tells you:

- The link name
- The regions that it commonly appears in
- What it is for and how to use it

You cannot perform all actions on all plans. For example:
• You cannot load, save, or close a plan that you have created but never launched.

• You cannot perform any action against a plan that is being saved or being re-planned (launched).

• You cannot load, save, or copy a plan that has failed its re-plan.

Change History

Use this action to view the changes that all planners have made to a plan.
It shows the entire change log for the plan in a pop up window.
Each change log entry shows the entity, who made the change, when they made the change, and the data values before and after the change.

Clear Comparisons

Use this action after you have done a plan comparison and you want to remove the comparison data.
It removes all comparison plan data and returns all tabs to the base plan data.

Close Plan

Use this action to close a plan that you have loaded into memory.

Copy Plan

Use this action to make copies of plans to save or simulate.
It opens the copy plan pop-up page with current plan as From Plan. Once you confirm the copy, the new plan appears in the list of plans.

Compare Plan

Use this action to compare plans.
It pops up a list of all plans and you select one plan.
If you have any of these tabs open, they are subject to the comparison between the base plan and the comparison plan:
• Supply and Demand
• Horizontal plans (material & resource)
• KPIs
• Exceptions

A tab that is subject to comparison typically:
• Automatically re-queries to show the comparison
• Gains an additional display column to show the plan name
• Does not allow for editing or drilling down of the comparison plan information

Create Plan

Use this action to create plans.
It opens the plan definition and options page in a pop-up window with an empty plan name and default values. Once you create a plan, you can see it in the list of plans.

Delete Plan

Use this action to delete plans.
This action purges the plan from memory and the database and is irrevocable.
When you run a copied plan, the planning solver needs its base plan base plan. If you delete a base plan, all plans copied from it are invalid.

Launch Plan

Use this link to re-plan plans.
It opens a launch plan page in a pop-up window.
Field Plan shows that plan that you currently have selected and you can select another one instead.
If you don’t have any plan selected, field Plan is blank and you can select one
You select :
• Incremental replan: Select this option if the simulation changes made in this plan are adding new manual demands. Do not use if you simulated anything else, that is, changed forecasts, supplies, or other reference data, for example, items.
• Launch Plan, do not refresh snapshot: Select this option if you want to do a complete solve and if the collected data has not changed since the last time you re-planned.
• Launch Plan, refresh snapshot: Select this option if you want to do a complete solve and if the collected data has changed, or if there are fresh simulations made in the simulation set since the last time you re-planned.
The progress bar shows the progress of the planning solver.

**Load Plan**

Use this action to load a plan from the database to memory.

You must load a plan before you can view, update, or simulate it.

It displays a plan status page in a pop-up window. Use this page to monitor the progress of each phase of the load. You can close this page and do other work and the load process keeps running.

**Release Plan**

Use this action to perform releases, reschedules, and cancellations in the current selected plan.

You can release the plan if you have not loaded it into memory.

It opens a release plan page in a pop-up window and asks you to confirm the release.

After you confirm, it opens a plan status page in a pop-up window. Use this page to monitor the progress of each phase of the release. It displays the concurrent request numbers of the processes.

To see how to mark orders for release, see Operating in Tabs.

If you are releasing a simulation that has changes to these types of data, the release process releases the order but does not release the component or resource requirement details:

- Bills of material, for example, component changes, effectivity changes
- Routings, for example, new operations

**Save Plan**

Use this action to save a plan from your workspace to the database.

It opens a save plan page in a pop-up window.

Field Plan shows the plan that you currently have selected and you can select another one instead.

Select a value for field Post-Save Options > Release recommendations:

- Do not release
- Release recommendations marked for release: After the save finishes, release orders marked for release
- Auto-release all plan recommendations: After the save finishes, release all the
orders that the plan recommends whether or not a planner has marked them for release

Select a value for field Post-Save Options > Publish analytics to APCC:

- Do not Publish

- Yes, and do not archive the previous version in APCC: After the save finishes, erase the plan analytics in Oracle Advanced Planning Command Center and send the analytics again

- Yes, and archive the previous version in APCC: After the save finishes, archive the current version the plan analytics in Oracle Advanced Planning Command Center and send the analytics again

After you confirm, it opens another save plan status page in a pop-up window. It displays the concurrent request number of the process.

**Multiple Planners Working On the Same Plan**

This is how Oracle Rapid Planning processes data when more than one planner is working on the same plan:

- Their saved changes are visible to one another

- A save or undo of changes by one planner saves or undoes the changes of all the planners

- A re-plan run by one planner locks out all planners from making changes to that plan

- If two planners are changing the same entity, the last one's change holds

- When one planner releases planned orders, the planned order information may not include unsaved changes by another planner. For example, a planner has mass-edited supplier capacity but not saved the changes. When another planner then releases planned orders, they are based on the previous supplier capacity.
Setting Up Oracle Rapid Planning

Architecture

Oracle Rapid Planning can work with:

- Oracle Advanced Planning and Scheduling releases 11i10 and 12.1.1 and Oracle Demantra/Oracle Demand Planning release 7.2.0.2
- Oracle e-Business Suite releases 11i10 and 12.1.1 (including Oracle Demand Planning)
- Oracle EnterpriseOne 9.0
- Third party systems

Deployment

To deploy Oracle Rapid Planning, consider your configuration and its collections and release processes.

Configuration

This table shows the configurations that you can use with Oracle Rapid Planning 1.0.

<table>
<thead>
<tr>
<th>Instance 1</th>
<th>Instance 2</th>
<th>Instance 3</th>
</tr>
</thead>
<tbody>
<tr>
<td>Oracle Rapid Planning release 1.0 + tech stack</td>
<td>- Oracle Advanced Planning and Scheduling release 11i10 with Oracle Demantra/Oracle Demand Planning</td>
<td>-</td>
</tr>
<tr>
<td></td>
<td>- Oracle e-Business Suite release 11i10</td>
<td></td>
</tr>
<tr>
<td>Instance 1</td>
<td>Instance 2</td>
<td>Instance 3</td>
</tr>
<tr>
<td>-----------</td>
<td>------------</td>
<td>------------</td>
</tr>
<tr>
<td>Oracle Rapid Planning release 1.0 + tech stack</td>
<td>Oracle Advanced Planning and Scheduling release 11i10 with Oracle Demantra/Oracle Demand Planning</td>
<td>Oracle e-Business Suite release 11i10</td>
</tr>
<tr>
<td>- Oracle Rapid Planning release 1.0 + tech stack - Oracle Advanced Planning and Scheduling release 12.1.1 with Oracle Demantra/Oracle Demand Planning</td>
<td>-</td>
<td>-</td>
</tr>
<tr>
<td>- Oracle Rapid Planning release 1.0 + tech stack - Oracle Advanced Planning and Scheduling release 12.1.1 with Oracle Demantra/Oracle Demand Planning</td>
<td>Oracle e-Business Suite releases 11i10 and 12.1.1</td>
<td>-</td>
</tr>
<tr>
<td>Oracle Rapid Planning release 1.0 + tech stack</td>
<td>Oracle EnterpriseOne release 9.0</td>
<td>-</td>
</tr>
<tr>
<td>Oracle Rapid Planning release 1.0 + tech stack</td>
<td>Third party systems</td>
<td>-</td>
</tr>
<tr>
<td>Oracle Rapid Planning release 1.0 + tech stack</td>
<td>- Oracle Advanced Planning and Scheduling release 11i10 with Oracle Demantra/Oracle Demand Planning</td>
<td>Oracle e-Business Suite release 11i10</td>
</tr>
</tbody>
</table>

**Collections and Release Process**

Generally:

- When Oracle Rapid Planning and Oracle Advanced Planning and Scheduling are not on the same instance, you collect data from Oracle Advanced Planning and Scheduling to Oracle Rapid Planning.

- When Oracle Rapid Planning and Oracle Advanced Planning and Scheduling are on the same instance, Oracle Rapid Planning can directly access all Oracle elements.
Advanced Planning and Scheduling data.

Collection of execution system data to the Oracle Rapid Planning instance uses the same collections processes as Oracle Advanced Supply Chain Planning. You launch them using the Oracle Advanced Supply Chain Planning concurrent request form. See Oracle Advanced Supply Chain Planning Implementation and User’s Guide.

Release suggestions from Oracle Rapid Planning to Oracle e-Business Suite. This includes planned orders for new, rescheduled, and cancelled discrete jobs, purchase requisitions, purchase orders, and transfers.

**Collection of Oracle Demantra Forecasts to the Rapid Planning Server**

There is a concurrent program that collects Oracle Demantra forecasts to the Oracle Rapid Planning server. For additional information about configuring Rapid Planning and its plans for integration with S&OP, please refer to "Demantra Sales and Operations Planning to Rapid Planning Integration", Oracle Demantra Implementation Guide.

**Parallel Collections from EBS 11i10**

Oracle Rapid Planning collections can run a dual data collections from an Oracle e-Business Suite 11i10 source instance to an Oracle Advanced Planning and Scheduling 11i10 instance and an Oracle Rapid Planning 1.0 instance.

The dual collections process:

- Collects source data from the 11i10 Oracle e-Business Suite 11i10 source instance
- Transports the data to the Oracle Advanced Planning and Scheduling 11i10 staging tables
- Then transports from the Oracle Advanced Planning and Scheduling 11i10 staging tables to the Oracle Rapid Planning instance staging tables.
- You must run an operational data store load must on the Oracle Rapid Planning instance to move data from the staging tables to the operational data store to be available for Oracle Rapid Planning.

The collections concurrent request on the the Advanced Planning and Scheduling instance includes the option to transport data from the ST tables to an Oracle Rapid Planning instance. This will also cause the operational data store load to run on the Oracle Rapid Planning instance.

**Releasing Planned Orders**

If you integrate Oracle Rapid Planning to Oracle Value Chain Planning releases 11.5.10 or 12, you must do this setup if you want to release planned orders from the Oracle Advanced Supply Chain Planning Planner Workbench.
Create an Oracle Supply Chain Simulation Planner. You must create a responsibility in the source instance (11.5.10) that conforms to the specifications:

- Responsibility Name: Oracle Supply Chain Simulation Planner
- Application: Oracle Manufacturing
- Description: Oracle Rapid Planning planned order release
- Menu: SCP_TOP_4.0
- Data Group Name: Standard
- Application: Oracle Manufacturing
- Request Group: All SCP Reports
- Application: Oracle Master Scheduling/MRP

Assign this responsibility in the source instance to user names that are authorized to run the Oracle Rapid Planning release process. The responsibility key is ADV_SUPPLY_CHAIN_SIM_PLANNER.

Function and Data Security

Use the Oracle Rapid Planning security features if you want to:

- Secure plans: Make a plan private and selectively grant access to others
- Restrict access to menu items, for example, Plan Inputs and Plan Actions
- Have multiple users working on the same plan, but separate their edits and updates
- Allow external partners to update plan information

There are these types of security in Oracle Rapid Planning:

- Function security: You assign Oracle Rapid Planning functions to responsibilities.
- Data security: You grant access by responsibilities to plans and organizations

Function Security

You can allow or deny these functions to each responsibility:

- Create
- Update/Edit
- Delete
• Launch
• Save
• Close
• Load
• Copy
• Release

If you do not allow Update/Edit privilege to a responsibility, users with that responsibility:
• Cannot make changes or edits in the Oracle Rapid Planning Plan Output tab, Plan Inputs tab, Personal Query definitions, and Report Layout definition
• Can only use public layouts to view reports

The seeded responsibility is Oracle Supply Chain Simulation Planner and it allows all the functions.

To allow or deny access, use responsibility System Administrator

Data Security

You can assign plans and organizations to a responsibility.

Data Security: Organization Security

If you assign an organization to a responsibility, users with that responsibility can access all the items in any public plan in that organization.

For example, there are these four plans in Oracle Rapid Planning that plan these organizations:
• Plan_1: Plans organizations SLC:M1, SLC:D1, and SLC:D2
• Plan_2: Plans organizations SLC:M1, SLC:M2, and SLC:D1
• Plan_3: Plans organizations SLC:M2 and SLC:D2
• Plan_4: Plans organizations SLC:M1, SLC:M2, and SLC:D2

User_1 belongs to responsibility Res_1 that has organization SLC:D1 assigned. User_1 has access to Plan_1 and Plan_2.

User_2 belongs to responsibility Res_2 that has organizations SLC:D1, SLC:D2, SLC:M1, and SLC:M2 assigned. User_2 has access to all four plans.

To assign an organization to a specific responsibility, use responsibility Advanced Planning Administrator.
Data Security: Plan Security

You can create two security types of plans:

- Public
- Private

For public plans, any user who has the correct organization security can see them.

To set a plan as public, use window Plan Options > tab Main. Select checkbox Public.

For private plans:

- The creator grants access to other users. Use window Plan Options > tab Main > field Users > button ADD.
- Users who have access to a private plan have access to all of the items and organizations in the plan
- The user can perform actions based on the function security of their responsibility

For example:

- User_A has privileges load and close
- User_B has all privileges
- User_A’s responsibility is assigned organizations SLC:M1 and SLC:M2
- User_B’s responsibility is assigned organizations SLC:M1, SLC:M2, SLC:S1, SLC:S2, SLC:D1, and SLC:D2

User_B creates private Plan_B and assigns it to User_A. User_A:

- Has access to all the items and organizations in the plan, because it is a private plan
- Is not able to launch or edit the plan

User_B creates public Plan_P that plans organizations SLC:M1, SLC:M2, SLC:S1, SLC:S2, SLC:D1, and SLC:D2. User_A:

- Has access to the plan
- Can only see organizations SLC:M1 and SLC:M2

Security Checking of Entities

These tables show the information that is and is not visible to users subject to security checking.

Security Checking of Entities: Plan Actions

These are controlled by function security
<table>
<thead>
<tr>
<th>Plan Action</th>
<th>Check Function Security</th>
<th>Check Data Security</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Create Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Load Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>List of plans is controlled by data security.</td>
</tr>
<tr>
<td>Copy Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>From plan filter is controlled by data security.</td>
</tr>
<tr>
<td>Save Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>Plan filter is controlled by data security.</td>
</tr>
<tr>
<td>Launch Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>Plan filter is controlled by data security.</td>
</tr>
<tr>
<td>Release Plan</td>
<td>Yes</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Close Plan</td>
<td>Yes</td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Delete Plan</td>
<td>Yes</td>
<td>Yes</td>
<td>Plan filter is controlled by data security.</td>
</tr>
<tr>
<td>Compare Plan</td>
<td>No</td>
<td>Yes</td>
<td>Plan name filter is controlled by data security.</td>
</tr>
<tr>
<td>Plan Options</td>
<td>Yes</td>
<td>Yes</td>
<td>- Organization filter is controlled by data security.</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Accessible if the function security is Create or Update</td>
</tr>
</tbody>
</table>

**Security Checking of Entities: Plan Links**

These are controlled by function security.
You can edit in these plan links if you have access to the Edit/Update action.

For searches:

- The list of values in the search frame is not limited by data security
- The results display is limited by the organizations that you have access to

For the Supply & Demand page:

- You see the full pegging information
- In context sensitive drill-downs, you can see only the organizations that you have access to

For contract manufacturing or in supporting external organizations, set a flag to control whether to display the pegging information. It defaults to cleared.

<table>
<thead>
<tr>
<th>Plan Links</th>
<th>Feature</th>
<th>Check Data Security</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Supply &amp; Demand</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Supply &amp; Demand</td>
<td>Results</td>
<td>Yes</td>
<td>- Displays full pegging information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Allows context-sensitive drill down depending on data security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Allows view only access to information that the user does not have organization access to</td>
</tr>
<tr>
<td>Material Plan</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Plan Links</td>
<td>Feature</td>
<td>Check Data Security</td>
<td>Comments</td>
</tr>
<tr>
<td>---------------</td>
<td>---------</td>
<td>---------------------</td>
<td>------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>Material Plan</td>
<td>Results</td>
<td>Yes</td>
<td>- For information displayed at the Category-Item and Item levels, do not apply data security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- For information displayed at the Item-Organization and Organization levels, apply data security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Allows context-sensitive drill down depending on data security</td>
</tr>
<tr>
<td>Analytics</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Analytics</td>
<td>Results</td>
<td>Yes</td>
<td>- Metrics display plan level information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- If organization is specifically a part of the report, only display organization level information</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Allows context-sensitive drill down depending on data security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>For example:</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Exception counts for an item: Do not apply data security</td>
</tr>
<tr>
<td></td>
<td></td>
<td></td>
<td>- Exception counts for an item at an organization: Apply data security</td>
</tr>
<tr>
<td>Plan Links</td>
<td>Feature</td>
<td>Check Data Security</td>
<td>Comments</td>
</tr>
<tr>
<td>--------------------</td>
<td>-----------------</td>
<td>---------------------</td>
<td>----------------------------------------------------</td>
</tr>
<tr>
<td>Exceptions</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Resource Availability</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Resource Plan</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Resource Requirements</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Items</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Resources</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Supply Chain Bill</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Bill of Material</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Suppliers</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Constraint Details</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
<tr>
<td>Processes</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
</tbody>
</table>
Security Checking of Entities: Plan Input Links

These are controlled by function security.

These links display collected and simulation set data. The links in this section are similar to the plan links section and have similar behavior. These are the unique plan input links.

<table>
<thead>
<tr>
<th>Plan Input Links</th>
<th>Feature</th>
<th>Check Data Security</th>
<th>Comments</th>
</tr>
</thead>
<tbody>
<tr>
<td>Calendar Search</td>
<td></td>
<td>No</td>
<td>-</td>
</tr>
<tr>
<td>Calendar Association</td>
<td>Search</td>
<td>Yes</td>
<td>Organization filter is controlled by data security.</td>
</tr>
</tbody>
</table>

Plan Options

Use this view to maintain plan options.

The plan options view has these tabs:

- Main
- Organizations
- Advanced

See Planning Server Logic, page 2-3 > Plan Options for information about the use of some plan options by the planning solver.

Plan Types

Oracle Rapid Planning plans are not differentiated by type. They have plan option RP Planning Item Type that affects plan output in the same way that plan type affects Oracle Advanced Supply Chain Planning plans. Values are:

- MPS: A master production schedule
- MPP: A master production plan
- MRP: A material requirements planning plan
- DRP: A distribution planning plan

Main Plan Options Tab

The plan options Organizations tab has regions for.
• General plan options: Define Plan Attributes

• Plan security: Define Plan Security Attributes

• Buckets and horizons: Define Plan Attributes

• Forecasting: Forecast Allocation and Consumption

Explose Forecast: specifies that the planning solver should explode configure to order forecasts. Do not select this option of you are driving the plan with pre-exploled forecasts.

Organization Plan Options Tab

The plan options Organizations tab has regions for.

• Organizations

• Global forecasts and sales orders: Global Demand Schedules

• Local forecasts and sales orders: Demand Schedules

The fields for subinventory netting appear on a separate window.

Ship to consumption level

: Specifies the forecasts that the planning solver should consume. Valid values are:

• Customer: Consumption occurs when item numbers and customer numbers match between the forecast entry and the sales order line.

• Customer Site: Consumption occurs when item numbers, customer numbers, and customer ship-to addresses match between the forecast entry and the sales order line.

• Zone: Consumption occurs when the item numbers and the zone to which the customer ship-to address belongs match between the forecast entry and the sales order line.

• Zone Customer: Consumption occurs when the item numbers, the zone containing the customer ship-to address, and the customer numbers match between the forecast entry and the sales order line.

• Demand Class: Consumption occurs when item numbers and demand class match between the forecast entry and the sales order line.

• Item-organization (default value): Consumption occurs when item numbers match between the forecast entry and the sales order line.

All values apply to global forecasts. For local forecasts, you can use Customer,
Customer Site, Demand Class, and Item-org.

Advanced Plan Options Tab

The plan options Advanced tab has the plan options that default from profile options.

MSC: Auto-Release Compression Days Tolerance
MSC: Consume Forecast Inside Demand Time Fence
MSC: Consume forecast with no demand class
MSC: Consume forecasts using Internal Sales Orders
MSC: Default Forecast Priority
MSC: Default Sales Order Priority
MSC: Firm Internal Requisition Transferred to OE
MSC: Inflate WIP Resource Requirements
MSC: Released WIP Jobs: Consider in Clear to Build
MSC: Released Only By User
MSC: Requisition Load Group Option
MSC: RP Group Planned Orders
MSO: Use Safety Lead Time

See also Oracle Advanced Supply Chain Planning Implementation and User’s Guide.

Profile Options

This table shows the Oracle Rapid Planning profile options.
<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Default Value</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
</table>
| MSC: Rapid Planning Consume Forecast with No Demand Class | Null          | Within Each Bucket, After Consuming Demand Class Specific Forecast, Null | This profile option specifies the order that the forecast consumption process should use to consume forecast entries when some of them have a demand class and some of them do not have a demand class. Valid values are:  
- Within Each Bucket: Consume forecast entries for the day on the sales order; it consumes entries with matching demand class first, then entries with no demand class. Then, it consumes forecast entries within the backward and forward consumption days; for each day, it uses matching demand class first, then no demand class.  
- After Consuming Demand Class Specific Forecast: The forecast consumption process starts by consuming forecast entries for the day on the sales order with matching demand class only. Then, it consumes forecast entries within the backward and forward consumption days with matching demand class only. If |
<table>
<thead>
<tr>
<th>Profile Name</th>
<th>Default Value</th>
<th>Values</th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td></td>
<td></td>
<td></td>
<td>there is a remaining sales order quantity, it repeats the process against forecast entries with no demand class, first on the day on the sales order, then within the backward and forward consumption days.</td>
</tr>
<tr>
<td>Profile Name</td>
<td>Default Value</td>
<td>Values</td>
<td>Description</td>
</tr>
<tr>
<td>--------------------------------------</td>
<td>---------------</td>
<td>--------</td>
<td>-------------------------------------------------------------------------------------------------------------------------------------------</td>
</tr>
<tr>
<td>MSC: Rapid Planning</td>
<td>None</td>
<td>None: Planned orders are not combined</td>
<td></td>
</tr>
<tr>
<td>Group Planned Orders</td>
<td></td>
<td>Demand Level: Combine planned orders if created while planning a single item demand</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Item Level: Combine all planned orders for an item</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>Determines if planned orders of the same type are grouped (while respecting order modifiers). Planned orders can only group if they share these attributes:</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Buy from items: Item, supplier, supplier site, ship method, suggested due date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Transfer from items: Item source organization, destination organization, ship method, suggested due date</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Make at items: Order level: source org, suggested start date, suggested due date, alternate bill of material and routing</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Component requirements level: All</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>- Resource: Capacity consumption start date and end date of all resource requirements</td>
<td></td>
</tr>
<tr>
<td>Rapid Planning Weblogic Server Home</td>
<td>Null</td>
<td>For example, /slot/xyz/abc/WLS/11gNN/WLS_Home</td>
<td></td>
</tr>
<tr>
<td></td>
<td></td>
<td>The path of the Oracle Rapid Planning Weblogic server home.</td>
<td></td>
</tr>
</tbody>
</table>
### Profile Name | Default Value | Values | Description
---|---|---|---
Released WIP Jobs: Consider in Clear to Build | No | Yes/No | Use this profile option to instruct the planning solver whether to calculate clear to build for released discrete jobs. Valid values are:
- Yes: Calculate clear to build for released discrete jobs
- No: Do not calculate clear to build for released discrete jobs

Oracle Rapid Planning uses the MSC: profile options that you set on the Plan Options > Advanced tab. See Plan Options, page 7-11.

The planning solver uses these technical profile options. These are not included in the Plan Options > Advanced tab:
- MSC: 64 Bit Planner Platform
- MSC: Debug Mode
- MSC: Enable 64 Bit snapshot
- MSC: Hour UOM
- MSC: Snapshot Workers
- MSC: Wait Time to Obtain Lock on Table or Partition for Snapshot Delete Worker (seconds)

These are other profile options that the planning solver uses. See *Oracle Advanced Supply Chain Planning Implementation and User’s Guide*:
- MRP: Plan Revenue Discount Percent
- MRP: Plan Revenue Price List
- MSO: Inventory Carrying Costs Percentage
A
alternate supplies, 2-3
analytics, 1-3
architecture, 7-1
area
  search, 4-1
  search results, 4-1
availability for update, 3-3

B
base metrics, 5-14
  clear to build component availability %, 5-14
  clear to build orders (%), 5-14
  fill rate, 5-14
  gross margin %, 5-14
  inventory turns, 5-14
  late orders ratio, 5-14
  manufacturing cost, 5-14
  on time orders, 5-14
  purchasing cost, 5-14
  Ready to Build %, 5-14
  resource utilization %, 5-14
  revenues, 5-14
  safety stock violation days, 5-14
  stock out days, 5-14
  supplier capacity utilization %, 5-14
  top shortage components, 5-14
  top shortage suppliers, 5-14
bottleneck Resource planning, 2-3
clear to build, 2-19
collection, 1-2
configure to order, 2-3

daily bucketing, 2-3
data collection, 1-2
data security, 7-4
Demantra Sales and Operations Planning, 1-4
deployment, 7-1
end item substitution, 2-3
engineering change cut-in scenario, 1-4
exception messages
demand quantity not satisfied, 5-2
demand satisfied using end item substitution, 5-2
items below safety stock, 5-2
items with a shortage, 5-2
items with excess inventory, 5-2
late replenishment for forecast, 5-2
late replenishment for sales order, 5-2
late supply pegged to forecast, 5-2
late supply pegged to sales order, 5-2
order sourced from alternate facility, 5-2
order sourced from alternate supplier, 5-2
orders to be cancelled, 5-2
orders to be rescheduled in, 5-2
orders to be rescheduled out, 5-2
order with insufficient lead time, 5-2
past due orders, 5-2
planned order uses alternate bom/routing, 5-2
planned order uses alternate resource, 5-2
planned order uses substitute component, 5-2
resource overloaded, 5-2
sales order/forecast at risk due to a resource shortage, 5-2
supplier capacity overloaded, 5-2
exceptions
  overview, 5-1

F
feature comparison, 2-3
firming, 4-
flow manufacturing, 2-3
function security, 7-4

H
hot demand scenario, 1-4

I
incremental planning, 2-3
integrations, 1-3
item attributes, 2-3
items to plan, 2-3

K
key performance indicators, 1-3

M
mass update, 4-1
menus, 3-1
metrics
  exception-based, 5-13
  overview, 5-13
metrics
  base, 5-14
multiple planners working on the same plan, 6-5

O
operating in tabs, 4-1
order and resource firming, 2-3
order release, 2-3
order types firming, 4-12
other planning functions, 2-3

overview
  analytics, 1-3
  data collection, 1-2
  integrations, 1-3
  Oracle Rapid Planning, 1-1
  planning solver, 2-1
  rapid planning solver, 1-3
  rapid planning workbench, 1-3
  simulation set, 1-2
overview
  plan comparison, 1-3

P
pegging, 2-3
phantoms, 2-3
plan
  availability for update, 3-3
  plan comparison, 1-3
  plan inputs tab, 4-1
  planning solver, 1-3, 2-1
    logic, 2-3
  planning time fence, 2-3
  plan options, 7-11
  plan options comparison, 2-3
  plans tab, 4-1
  plan state, 6-1
profile options, 7-13
  MRP: Plan Revenue Discount Percent, 7-17
  MRP: Plan Revenue Price List, 7-17
  MSC: 64 Bit Planner Platform, 7-17
  MSC: Auto-Release Compression Days Tolerance, 7-13
  MSC: Choice of Items for which to Create Supplies in a Substitute Relationship, 2-18
  MSC: Consume Forecast Inside Demand Time Fence, 7-13
  MSC: Consume forecasts using Internal Sales Orders, 7-13
  MSC: Consume forecast with no demand class, 7-13
  MSC: Debug Mode, 7-17
  MSC: Default Forecast Priority, 7-13
  MSC: Default Sales Order Priority, 7-13
  MSC: Enable 64 Bit snapshot, 7-17
  MSC: Firm Internal Requisition Transferred to OE, 7-13
MSC: Hour UOM, 7-17
MSC: Inflate WIP Resource Requirements, 7-13
MSC: New Planner Backward Compatibility, 2-7
MSC: Rapid Planning Consume Forecast with No Demand Class, 7-14
MSC: Rapid Planning Group Planned Orders, 7-16
MSC: Released Only By User, 7-13
MSC: Released WIP Jobs: Consider in Clear to Build, 7-13
MSC: Requisition Load Group Option, 7-13
MSC: Snapshot Workers, 7-17
MSC: Wait Time to Obtain Lock on Table or Partition for Snapshot Delete Worker (seconds), 7-17
MSC Use Safety Lead Time, 2-14
MSO: Choice of supply for substitution, 2-18
MSO: Disable Inference of Item Substitution Relationship, 2-18
MSO: Inventory Carrying Costs Percentage, 7-17
MSO: Use Effectivity Dates to Infer End Item Substitute Priority, 2-18
MSO: Use Safety Lead Time, 7-13
Rapid Planning Weblogic Server Home, 7-16
Released WIP Jobs: Consider in Clear to Build, 7-17

R
rapid planning solver, 1-3
rapid planning workbench, 3-1
releasing, 4-12
resource downtime scenario, 1-4
responsibility, 3-1

S
safety stock lead time, 2-3
saving data, 4-1
scenarios
  engineering change cut-in, 1-4
  hot demand, 1-4
  resource downtime, 1-4
  yield bust, 1-4

T
tab
  plan inputs, 4-1
  plans, 4-1
tabs
  operating in, 4-1

U
unconstrained planning, 2-3
update
  availability for, 3-3

W
workbench, 1-3, 3-1
workbench actions
  change history, 6-1
  clear comparisons, 6-1
  close plan, 6-1
  compare plan, 6-1
  copy plan, 6-1
  create plan, 6-1
  delete plan, 6-1
  launch plan, 6-1
  load plan, 6-1
  release plan, 6-1
  save plan, 6-1
workbench view
  analytics, 4-12
  bills of materials, 4-12
calendar association, 4-12
calendars, 4-12
constraint details, 4-12
exceptions, 4-12
items, 4-12
manage simulation sets, 4-12
material plan, 4-12
resource availability, 4-12
resource plan, 4-12
resource requirements, 4-12
resources, 4-12
suppliers, 4-12
supply & demand, 4-12
supply chain bill, 4-12

Y

yield bust scenario, 1-4